
 

HYDRO-MECHANICAL ANALYSIS OF LOW ENRICHED URANIUM FUEL PLATES FOR 
UNIVERSITY OF MISSOURI RESEARCH REACTOR 

A Thesis presented to the Faculty of the Graduate School 

University of Missouri 

 

In Partial Fulfillment 

Of the Requirements for the Degree 

Master of Science 

 

by 

JOHN C. KENNEDY 

Dr. Gary L. Solbrekken, Thesis Supervisor 

MAY 2012 

 

  



 

The undersigned, appointed by the Dean of the Graduate School, have examined the 

thesis entitled 

HYDRO-MECHANICAL ANALYSIS OF LOW ENRICHED URANIUM FUEL PLATES FOR 

UNIVERSITY OF MISSOURI RESEARCH REACTOR 

Presented by John C. Kennedy 

A candidate for the degree Master of Science 

And hereby certify that in their opinion it is worthy of acceptance 

 

Dr. Gary L. Solbrekken 

 

Dr. Douglas E. Smith 

 

Dr. Stephen Montgomery-Smith 

 

  



 ii 

ACKNOWLEDGEMENTS 

 I would first like to thank my advisor, Dr. Gary Solbrekken, for his support during 

this research project.  His continued encouragement, patience, and input have been 

invaluable in the completion of this project.  Next, I must thank my parents, John and 

Lisa, my brother Josh, and my grandmothers Donna and Marita.  Their encouragement 

from an early point in my life to pursue science and engineering has led me to where I 

am today.  Without their immense support, none of this would have been possible.  

Finally, my colleagues throughout this project have been incredibly supportive, even 

during the most trying moments.  In particular I would like to thank Kyler Turner, 

Srisharan G. Govindarajan, Philip Makarewicz, Bobby Slater, and Logan Compton for 

their help throughout this project. 

  



 iii 

TABLE OF CONTENTS 

ACKNOWLEDGEMENTS ........................................................................................................ii 

LIST OF FIGURES .................................................................................................................. vi 

LIST OF TABLES .................................................................................................................. viii 

NOMENCLATURE ................................................................................................................. ix 

Abstract ............................................................................................................................... xi 

Chapter 1: INTRODUCTION AND PURPOSE .................................................................... 1 

Forward ........................................................................................................................... 1 

History and Background .................................................................................................. 1 

Global Threat Reduction Initiative (GTRI) ....................................................................... 3 

Engineering Analysis Techniques .................................................................................... 5 

Purpose of Study ............................................................................................................. 8 

Chapter 2: University of Missouri Research Reactor .................................................... 11 

MURR Conversion ......................................................................................................... 11 

Current MURR HEU design ........................................................................................... 11 

Proposed LEU design..................................................................................................... 13 

Design Concerns ............................................................................................................ 14 

Chapter 3: Numeric Modeling ...................................................................................... 16 

Code Coupling Process .................................................................................................. 16 



 iv 

CFD Solution Process .................................................................................................... 17 

FEM Solution Process .................................................................................................... 21 

Stability ......................................................................................................................... 22 

Efficiency ....................................................................................................................... 24 

Chapter 4: Analytic Modeling ....................................................................................... 26 

Flow Model Development ............................................................................................ 26 

Deflection Model Development ................................................................................... 29 

Chapter 5: Flat Plate Modeling ..................................................................................... 31 

Computational Models ................................................................................................. 31 

Experimental Setup ....................................................................................................... 35 

Chapter 6: Flat Plate Results and Discussion ................................................................ 41 

Experimental Results .................................................................................................... 41 

Computational Results .................................................................................................. 46 

Chapter 7: Conclusion and Future Work ...................................................................... 57 

APPENDIX 1: Numeric Procedure (Tutorial) ..................................................................... 59 

Introduction .................................................................................................................. 59 

Preparing for Coupled Simulations ............................................................................... 59 

Required Software .................................................................................................... 59 

System Configuration ................................................................................................ 60 



 v 

Preparing the Abaqus Solid Model ............................................................................... 61 

Building the Model in Abaqus CAE ........................................................................... 61 

Editing the Abaqus INput File ................................................................................... 85 

Preparing the Star-CCM+ Fluid Model .......................................................................... 87 

Building the Fluid Model ........................................................................................... 88 

APPENDIX 2: Experimental Data ..................................................................................... 123 

APPENDIX 3: Numeric Data ............................................................................................. 126 

REFERENCES .................................................................................................................... 129 

 

  



 vi 

LIST OF FIGURES 

1. Current HEU dispersion fuel cross-section ........................................................... 11 

2. Current MURR HEU Fuel Element (MURR, 2011). ................................................ 12 

3. MURR fuel element arrangement (MURR, 2011). ................................................ 13 

4. Plate 23 cross section.  0.4572 mm (18 mil) thick U-10Mo foil clad with 0.025 

MM (1 Mil) Zirconium and 0.229 mm (9 mil) aluminum. ..................................... 14 

5. FSI Co-Simulation Process ..................................................................................... 16 

6. Basic Geometry from CFD model.  Note the gap in the middle of the flow channel 

for the plate. ......................................................................................................... 17 

7. Examples of Mesh, pressure, and velocity at the leading edge of a plate. .......... 18 

8. Abaqus node and element surface definitions (Simulia, 2011). ........................... 21 

9. FEA model mesh, stress, and deflection plots ...................................................... 22 

10. Assembly Geometry.  Fluid flow is from the top down ........................................ 26 

11. Flow Channel Contraction (left) and expansion (right). ....................................... 28 

12. Plate model setup ................................................................................................. 31 

13. Simulated geometry. Note b is the plate width.................................................... 32 

14. Abaqus mesh independence deflection results.................................................... 33 

15. Percent Change in plate pressure drop as mesh density increases ..................... 34 

16. Missouri Flow Loop ............................................................................................... 36 

17. Flat Plate Test Section. .......................................................................................... 37 

18. Channel gap profiles. ............................................................................................ 38 

19. Channel gap at midpoint during intial test phase. ............................................... 41 

file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768408
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768409
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768410
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768411
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768411
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768412
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768413
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768413
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768414
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768415
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768416
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768417
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768418
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768419
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768420
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768421
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768422
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768423
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768424
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768425
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768426


 vii 

20. Flow rate during the initial test phase. ................................................................. 42 

21. Flow Channel Velocity during initial testing phase. .............................................. 43 

22. Maximum plate deflection Vs. Flow Velocity. ...................................................... 44 

23. Channel pressure profiles at max flow rate. ......................................................... 45 

24. Plate pressure differential. ................................................................................... 46 

25. FSI Model velocity ramping schemes. .................................................................. 49 

26. Deflection profile caused by numeric instability in Model 1. ............................... 50 

27. Comparison of the mesh from model 1 (left) and model 2 (right). ...................... 51 

28. Deflection profile caused by numeric instability in Model 1. ............................... 52 

29. Pressure differential through plate ...................................................................... 53 

30. Model 2 static pressure distributions ................................................................... 53 

31. Leading Edge Deflection Profile at Various Velocities. ......................................... 54 

32. Average Deflection Comparison between Numeric and Analytic Models ........... 55 

A1. Flow rate data from phase 2 of flow test. .......................................................... 123 

A2. Channel gap data from Phase 2 of Flow Test. .................................................... 123 

A3. Flow rate data from phase 3 of flow test. .......................................................... 124 

A4. Channel gaps during phase 3 of flow test. ......................................................... 125 

  

file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768427
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768428
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768429
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768430
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768431
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768432
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768433
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768434
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768435
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768436
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768437
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768438
file://192.168.137.1/FuelResearch/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20FinalDraft.docx%23_Toc323768439
file:///J:/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20Working%20Draft%202.docx%23_Toc321351176
file:///J:/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20Working%20Draft%202.docx%23_Toc321351177
file:///J:/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20Working%20Draft%202.docx%23_Toc321351178
file:///J:/Reports/2011%20-%20Master's%20Thesis/Thesis%20-%20Working%20Draft%202.docx%23_Toc321351179


 viii 

LIST OF TABLES 

1. Summary Of Assembly Dimensions. ..................................................................... 39 

2. Thickness measurements at center, leading edge of plate. ................................. 39 

3. FSI Model Properties ............................................................................................. 48 

  



 ix 

NOMENCLATURE 

a Plate thickness 

A1 Upstream flow area 

A2 Downstream flow area 

b Plate width 

Dh Hydraulic diameter 

E Young’s modulus of 

elasticity 

f Friction factor 

G Grid flux 

g1 Channel 1 outer wall to 

plate mid-plane thickness 

g2 Channel 2 outer wall to 

plate mid-plane thickness 

h1 Channel 1 thickness 

h2 Channel 2 thickness 

I Moment of inertia 

L Plate length 

 ̇ Mass flow rate 

Re Reynold’s number 

S Source term 

t Time 

V Volume 

 

Greek 

αR Mass proportional 

Rayleigh damping factor 

βR Stiffness proportional 

Rayleigh damping factor 

Γ Diffusion coefficient 

δ Deflection 

δAVE Average deflection 

δMAX Maximum deflection 

ε Surface roughness 

μ Dynamic viscosity 

ν Poisson’s Ratio 

ξ Fraction of critical 

damping 

ρ Density 

φ General CFD transport 

quantity 

ω Natural frequency 

Vectors 

 ⃗ Area vector 

 ⃗ Velocity vector 

 

 



 x 

Subscripts 

f Cell face identifier 

i Iteration 

n Time level  

Abbreviations 

ANL Argonne National 

Laboratory 

ATR Advanced Test Reactor 

CFD Computational Fluid 

Dynamics 

DOE Department of Energy 

FEM/FEA Finite Element 

Method/Analysis 

FSI Fluid Structure 

Interaction 

GTRI Global Threat Reduction 

Initiative 

HEU Highly Enriched Uranium  

HFIR High Flux Isotope Reactor 

INL Idaho National 

Laboratory 

LEU Low Enriched Uranium  

MITR Massachusetts Institute 

of Technology Reactor 

MU University of Missouri 

MURR University of Missouri 

Research Reactor 

NBSR National Bureau of 

Standards Reactor 

NIST National Institutes of 

Standards and 

Technology 

NNSA National Nuclear Security 

Administration 

ORNL Oak Ridge National 

Laboratory 

RERTR Reduced Enrichment for 

Research and Test 

Reactors 

RDD Radiological Dispersion 

Device 

U-235 Uranium 235 (fissionable) 

U-238 Uranium 238 (common) 

USHPRR United States High 

Performance Research 

Reactors 

WMD Weapons of Mass 

Destruction 

  



 xi 

Abstract 

As part of the Global Threat Reduction Initiative (GTRI) Reactor Conversion 

program, work is underway to analyze and validate a new fuel assembly for the 

University of Missouri Research Reactor (MURR).  The Low Enriched Uranium (LEU) 

design currently under investigation is a significant departure from the current High 

Enriched Uranium (HEU) design.  This includes a change in the fuel meat from U-Al 

dispersion to a monolithic U-10Mo composition.  Additionally, the proposed LEU plates 

are 25% thinner than the current HEU plates.  These design changes increase the 

potential for coolant flow induced deflection of the fuel plates which could lead to a 

local loss of coolant, and therefore a hot spot on a plate.  If the temperature on a fuel 

plate rises too high, there is a risk of fuel plate rupture and fission gas release into the 

coolant system. 

Previous methods for assessing fuel plate deflection have relied heavily on analytic 

and experimental techniques.  With the continued advancement of computational 

codes, new options are emerging to assess structural stability.  This research explores 

the potential of explicitly coupled fluid-structure interaction (FSI) numeric modeling.  

Work was completed to evaluate a method for coupling a computational fluid dynamics 

(CFD) code with a finite element analysis (FEA) code.  After coupling the codes and 

understanding the deficiencies in the coupling technique, additional research was 

completed on methods to improve the stability and efficiency of coupled simulations.  

Pressure ramping, material damping, and mesh refinement were successfully used on 

simulations of high aspect ratio geometries to increase simulation stability and decrease 



 xii 

total runtime.  This research has successfully provided a way to analyze the complex 

interactions of fluid and structural systems.  These techniques will be invaluable in 

evaluating the proposed LEU fuel plate structure for MURR.  Additionally, proposals for 

future and ongoing work to validate results against fresh experimental and analytic 

models are provided.  
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Chapter 1: INTRODUCTION AND PURPOSE 

Forward 

 After World War II, nuclear technology began to play an ever expanding role in 

the modernization of science and technology.  At the core of much of this scientific 

progress has been the work of research and test reactors throughout the world.  This 

research has led to breakthroughs in fields ranging from medical radiopharmaceuticals 

to advanced polymer designs and next generation battery technology.  In order to 

accomplish this research, many of these reactors have relied upon highly enriched 

uranium (HEU) fuel.  The use of this fuel at civilian sites presents a significant security 

concern, as HEU material can be used as a weapon.  Therefore, under the guidance of 

the Global Threat Reduction Initiative (GTRI), work is currently underway to develop and 

qualify new low enriched uranium (LEU) based fuels for five domestic research and test 

reactors.  One of these reactors, the University of Missouri Research Reactor (MURR), is 

considering dramatic changes to their fuel structure.  These changes have led to 

concerns of the hydro-mechanical stability of the new fuel plates.  As a result, work is 

underway to validate the use of coupled computational fluid-structure interaction (FSI) 

modeling for analysis of nuclear reactor fuel plates. 

History and Background 

 In August of 1945, the world got its first glimpse of the nuclear age with the 

dropping of two atomic bombs on the Japanese cities of Hiroshima and Nagasaki.  With 

these acts, nuclear technology was largely perceived only as a massive destructive force.  

As a result, in the decades since the first use of nuclear weapons, countries around the 
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world have worked to develop their own nuclear arsenal.  Today, these efforts have 

expanded to include terrorist organizations, who are working to develop devices 

capable of spreading hazardous radiological material over a large area.  These 

radiological dispersion devices (RDDs) provide a simple, yet effective means of attack 

against western powers.  Perhaps recognizing the future threat of nuclear proliferation, 

President Eisenhower announced his Atoms for Peace initiative to the United Nations in 

1953 (Eisenhower, 1953).  The Atoms for Peace initiative was developed to encourage 

peaceful uses of nuclear technology to help solve a range of problems.  In the decades 

since this initial speech, nuclear research has expanded to areas including power 

production, radiopharmaceuticals, medical imaging, spacecraft propulsion, and 

advanced materials development.  These peaceful uses for nuclear technology have 

proven invaluable to the advancement of scientific research. 

 This research, however, has also increased the proliferation of potentially 

dangerous nuclear material.  Highly Enriched Uranium (HEU), defined as uranium with a 

concentration greater than 20% of U-235, was the primary fuel source for these 

reactors.  In the early 1960s, the first of these reactors were constructed in Iran and 

Pakistan.  These reactors and many that would follow were initially designed to utilize 

HEU, with U-235 enrichment sometimes reaching levels greater than 90%,  in order to 

achieve U-235 densities that were high enough for the targeted performance of the 

reactors.  At the time, there were limited known options for research reactor fuels, 

thereby limiting fuel design to HEU rather than LEU (Moses, 2005).  In the years to 
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follow most of the new research reactors constructed both as a part of the Atoms for 

Peace program and other programs utilized HEU fuel. 

 One of these early research reactors was the University of Missouri Research 

Reactor.  Beginning operation in 1966 as a 5 MW facility, MURR has gone on to support 

nearly 50 years of cutting edge research.  Upgraded in 1974 to 10 MW, MURR has 

operated with an HEU core throughout its entire existence (MURR, 2011).  Until 

recently, there were no technically or economically feasible alternatives to the current 

HEU core at MURR and several other reactors.  Under research conducted initially 

through the Reduced Enrichment for Research and Test Reactors (RERTR) program, and 

now through the Global Threat Reduction Initiative (GTRI), a new, high density LEU foil is 

being investigated as a possible alternative to the current HEU fuels in use at many 

reactors.  

Global Threat Reduction Initiative (GTRI) 

With the threats posed by nuclear terrorism and the advent of new methods for 

developing high density LEU foils, there is an effort currently underway to convert many 

US and international research reactors from their current HEU fuel to a new, foil based 

LEU fuel.  As part of the National Nuclear Security Administration (NNSA), the office of 

Global Threat Reduction is working to, “reduce and protect vulnerable nuclear and 

radiological materials located at civilian sites worldwide” (NNSA, 2011).  To date, the 

Global Threat Reduction Initiative has succeeded in removing more than 120 nuclear 

bombs worth of highly enriched uranium and plutonium from both fresh and waste fuel 

sites around the globe.  Additionally, the program has secured a large amount of 
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vulnerable nuclear and radiological material at sites around the world.  This material 

may be considered useful to a terrorist organization for the construction of nuclear 

weapons or dirty bombs.  As part of ongoing GTRI efforts in the US, work is underway to 

complete conversion of five domestic research and test reactors.  These reactors include 

MURR, the Advanced Test Reactor at Idaho National Laboratory, the High Flux Isotope 

Reactor at Oak Ridge National Laboratory, the MIT Reactor, and the National Bureau of 

Standards Reactor at the National Institute of Standards and Technology (Wachs, 2008). 

Since the start of the RERTR program, more than 40 reactors worldwide have been 

converted from HEU to LEU fuel (ANL, 2010).  Today, conversion efforts continue for 

only a handful of remaining HEU reactors in the United States as part of the Global 

Threat Reduction Initiative.  Additionally, the NNSA is working to expand HEU reduction 

efforts in other countries such as Russia (NNSA, 2011).  Aside from reactor fuel 

conversion, GTRI is also focused on securing sites that still use HEU but are unable to 

convert, as well as disposing of unnecessary nuclear material which is no longer used.  

These efforts have resulted in the removal and securing of enough nuclear material for 

thousands of dirty and nuclear bombs.



5 
 

Engineering Analysis Techniques 

 When many of the reactors now targeted for conversion, including MURR, were 

first designed, computational power had not yet reached a level that allowed for 

detailed analysis of complete reactor systems.  When the initial design work for these 

reactors was completed in the 1950s and 1960s, the majority of the analysis was based 

on conservative analytic modeling and experiments.  These efforts were sufficient at the 

time for producing quality reactor systems with high margins of safety.  However, due to 

the conservative nature of these engineering analyses, there was limited understanding 

of the true limits of the reactor systems.  With the expense required for complex 

experiments, it was impractical to experimentally simulate every possible scenario.  

Therefore, favoring analytic solutions, the work of D.R. Miller (Miller, 1958) was 

especially useful in determining an approximate critical coolant flow velocity at which 

reactor fuel plates may potentially fail.  MURR, like many reactors of the time, utilizes 

fuel assemblies based on a series of parallel fuel plates, with coolant flow channels 

between the plates.  In order to dissipate the heat produced in the fuel plates, water is 

pushed through these flow channels at high velocities.  Miller sought to determine the 

velocity at which the hydraulic force would become high enough to cause a plate to 

deform, thereby closing off a coolant channel.  This critical velocity is determined using 

simple Bernoulli flow and wide beam theory.  Miller’s formulation does not take into 

account the relationship between flow redistribution and plate deflection.  As a result, 

the critical velocity determined using the Miller formulation is highly conservative, and 

can be significantly improved. 
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 Seeking to build upon the work of Miller, several experimental studies were 

conducted in the 1960s.  In 1963, Groninger and Kane conducted tests on arrays of five 

parallel, flat plates.  In these tests, the plates were instrumented with strain gages in the 

side walls in order to measure the plate deflection at high flow rates.  The strain gages 

were calibrated for deflection measurements by pressurizing each flow channel with air 

and measuring the resulting strain and deflection.  The strain gages were then used to 

determine deflection at lower flow rates, until a violent flutter was encountered at 

approximately 1.9 times the Miller critical velocity.  When flow was decreased below the 

point of the onset of the flutter, the flutter stopped (Groninger & Kane, 1963).  Similarly, 

in 1964, a study completed by Scavuzzo analyzed a geometry with a single flat plate with 

channels of differing thickness.  This work looked at the effect of non-uniform channel 

thicknesses on plate deflection.  It was observed that the plate will deflect at velocities 

below the Miller critical velocity if the flow channels are of different thicknesses.  

Additionally, a non-dimensional analytic model was developed for comparison to Miller 

(Scavuzzo, 1965). 

 In 1968, Smissaert continued this analysis by looking at arrays of five parallel, flat 

plates.  In these tests, one of the goals was to duplicate the flutter effect seen by 

Groninger and Kale.  In order to achieve flutter at lower flow rates, PVC plates with a 

lower elastic modulus than aluminum were used.  This allowed for the flutter effect to 

be observed at lower flow rates than what was necessary previously.  In these tests, the 

flutter effect was seen at approximately 2.2 times the Miller velocity.  Additionally, the 

frequency of vibration and the speed of the wave down the length of the plate were 
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recorded.  These tests expanded significantly on the initial work at the beginning of the 

decade, while also demonstrating the need for additional investigation (Smissaert, 

1968). 

 More recently, experimental work has been done to investigate the potential for 

flow induced deflection in the Australian Replacement Research Reactor (RRR).  This 

work showed plate collapse occurring at 78% of the predicted Miller critical velocity, a 

lower velocity than previous studies.  Additionally, plastic deformation was observed at 

higher flow rates and the frequency of vibration was monitored using strain gages (Ho, 

Hong, & Mack, 2004). 

 As numeric modeling gains popularity, much work has been done in recent years 

to evaluate the feasibility of numerically coupled fluid structure interaction (FSI) 

simulations.  Typically, structural problems are solved using a Lagrangian algorithm 

which involves having the nodes of a mesh follow the motion of the continuum.  This 

differs from the Eulerian technique used in fluid dynamics where a fixed mesh is used to 

solve for a continuum moving relative to a grid.  A hybrid approach, known as Arbitrary 

Lagrangian-Eulerian (ALE) permits the flexing of a mesh similar to a Lagrangian solution, 

but also monitors motion relative to the grid like an Eulerian method (Donea, Huerta, 

Ponthot, & Rodriguez-Ferran, 2004).  This method requires a compromise of both the 

fluid and solid domain solutions by forcing them to use a hybrid solution method rather 

than a typical Lagrangian or Eulerian approach.  Additionally, this technique provides for 

meshing of both domains with a single grid rather than independent grids.  Research 

using this method has focused on the difficulty in maintaining reasonable meshes, 
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establishing computational efficiency, and determining ways to analyze transient 

problems (Dowell & Hall, 2001).  When it comes to applying the ALE method, some 

previous work has focused on laminar flow with small deformations (Razzaq, Turek, 

Hron, & Acker, 2010). 

 Other studies of numeric FSI modeling have examined issues of stability 

associated with separately defined grids for the fluid and solid domains.  It has been 

shown that simulations which maintain the original finite volume definition of the fluid 

domain and the finite element definition of the solid domain are highly sensitive to the 

velocity of the interface.  If the coupled interface moves at too high a speed, or 

experiences a relatively large deformation at a specified time interval, instabilities can 

arise in the solution (Roe, Haselbacher, & Geubelle, 2007). 

Purpose of Study 

 Today, as computer systems continue to see gains in speed and capability, most 

engineering analysis is done numerically.  The two dominant methods of analysis are 

divided by the type of system that is being analyzed.  For fluid systems, computational 

fluid dynamics (CFD) is commonly used.  CFD solvers discretize the fluid region into a set 

of finite volume cells, and then solve for the flow properties in these cells.  For solid 

systems, finite element method (FEM) is commonly used.  FEM solvers discretize the 

structure of a solid into a set of solid elements composed of nodes.  The code solves the 

solid mechanics equations at these nodal locations, providing the user with data on the 

deflection, stress, and strain in the model. 
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While many codes offer the ability to solve FSI problems using only CFD or FEM 

methods, they are limited in their ability since they are being used to solve for domains 

for which they are not optimized.  Therefore, there is a growing interest in combining 

the power of CFD and FEM solvers for problems involving Fluid Structure Interaction 

(FSI).  Such an approach would allow for a CFD code to solve for the fluid domain and an 

FEM code to solve for the solid domain, thereby giving the user the best of both worlds 

by ensuring that each domain is solved by the optimal code.  Until recently, 

computational FSI solutions were limited by the type of problem that they could be 

applied to, as well as the availability of computational power.  Additionally, FSI codes up 

to this point have generally been self-written.  The research presented here explores a 

not only a new application for FSI modeling of flow between reactor fuel plates, but also 

a new technique that is dependent on commercially available codes.  The primary focus 

of this research is to validate FSI solutions using Star-CCM+, a commercial CFD code, and 

Abaqus, a commercial FEM code. 

Given the previous work done in this field, particular emphasis is placed on 

developing techniques for stabilizing the numeric solution.  As was noted by Roe, 

particular emphasis must be placed on controlling the velocity of the interface between 

the fluid and solid domains.  This becomes particularly important when the high aspect 

ratio of the geometry is considered.  A high aspect ratio, such as that seen in the cross 

section of reactor coolant channels means that even small deflections of a plate can 

result in large changes to the fluid solution.  Controlling and maintaining stability as the 

FSI interface moves through the fluid domain is the prime concern of this research.  
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Additionally, since previous experiments dating back to the 1960s show inconsistent 

results, a flow loop and test section have been constructed to aid in determining the 

accuracy of the numeric solutions.  
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Chapter 2: University of Missouri Research Reactor 

MURR Conversion 

 Along with four other US High Performance Research Reactors (USHPRR), MURR 

is currently working to validate the safety and performance characteristics of a new LEU 

fuel.  As the primary design constraints for the new MURR fuel, particular emphasis has 

been placed on maintaining the current neutron flux and neutron energy distribution 

within the irradiation spaces of the reactor.  This will ensure that after conversion MURR 

will be able to continue its current research and production missions.  Additionally, as 

multiple designs have been identified for new LEU fuel plates, the costs of the new fuel 

assembly options has been an important factor.  These criteria have led to selection of a 

new, thin plate fuel design.  Once the review process is complete and the MURR core is 

converted to an LEU fuel, the research reactor will be able to continue operation well 

into the future without using an HEU fuel core. 

Current MURR HEU design 

 Currently, MURR operates as the nation’s most powerful university research 

reactor at 10 MW.  In 1971, MURR converted from its initial uranium-aluminum alloy 

fuel to the uranium-aluminide dispersion fuel shown in Figure 1.  This conversion 

 
 

Aluminum 
Cladding 

Uranium-Aluminide 
Dispersion fuel meat 

FIGURE 1.  CURRENT HEU DISPERSION FUEL CROSS-SECTION 
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allowed for an increase in 235U loading from 650 grams per element to 775 grams.  The 

fuel meat portion of the plate is 0.508 mm (20 mils) thick, with 0.381 mm (15 mils) of 

aluminum cladding on either side.  With a total plate thickness of 1.27 mm (50 mils), the 

channel gap for coolant flow is 2.032 mm (80 mils).  Each fuel assembly, as shown in 

Figure 2, contains 24 fuel plates arranged in a concentric orientation, and the fuel is 

enriched to 93% 235U. 

The MURR core is composed of eight fuel assemblies, placed in a ‘pie’ 

arrangement, as shown in Figure 3.  The core is highly compact, with outer and inner 

pressure vessel diameters of 29.97 cm (11.80 inches) and 13.51 cm (5.32 inches), 

respectively.  The length of the fuel plates is 64.77 cm (25.5 inches), leading to core 

volume of 1.46 x 10-1 m3 (5.14 ft.3).  In order to remove the 10 MW of heat produced in 

FIGURE 2. CURRENT MURR HEU FUEL ELEMENT (MURR, 2011). 



 13 

this volume, water is pushed through the core at high velocity, carrying heat away to 

external cooling towers.  The current HEU design is resistant to flow induced deflections 

of the fuel plates for several reasons.  The thickness and curvature of the plates provide 

sufficient rigidity to minimize deflection.  Additionally, each fuel assembly is equipped 

with combs on the leading and trailing edges, which hold the fuel plates in place at 

those locations.  These factors all provide for a stable design in the current HEU core. 

Proposed LEU design 

 With the need to reduce 235U enrichment from the current 93% to 19.75%, a new 

fuel foil composed of uranium and 10% molybdenum has been developed.  In order to 

make up for the reduced fraction of 235U present in the new fuel, the fuel density has 

increased from 1.53 grams/cm3 to 3.03 grams/cm3.  In the majority of the plates, the 

uranium foil itself is only 0.457 mm (18 mils) thick, and is clad on either side by 

aluminum with a thickness of 0.229 mm (9 mils), as shown in Figure 4.  Between the 

uranium foil and the aluminum cladding, a 0.025 mm (1 mil) thick zirconium layer is 

present to prevent interactions between the two materials during irradiation.  These 

FIGURE 3.  MURR FUEL ELEMENT ARRANGEMENT (MURR, 2011). 
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thickness values result in a total plate thickness of 0.965 mm (38 mils) for plates 2 

through 23.  Plates 1 and 24, the inner and outermost plates, are each 1.245 mm (49 

mils) thick (MURR, 2011).  With the thinning of the plates, the volume of water in the 

LEU core is higher than the present HEU core.  This higher water volume provides 

greater neutron moderation, resulting in longer life and lower cost for the fuel 

elements. 

Design Concerns 

 With the new LEU fuel plates being 24% thinner than the current HEU fuel 

plates, there is some concern about the loss in stiffness associated with the thinning of 

the plates.  Additionally, with the layered composite structure, there is a potential slip 

 

38 mils total 

18 mils fuel 

FIGURE 4. PLATE 23 CROSS SECTION.  0.4572 MM (18 MIL) THICK U-10MO FOIL CLAD WITH 
0.025 MM (1 MIL) ZIRCONIUM AND 0.229 MM (9 MIL) ALUMINUM. 
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plane present at the interface between the clad and the fuel.  These changes could 

potentially allow the coolant flow between the fuel plates to cause the plates to deflect 

into the coolant channel.  This deflection would lead to a reduction in local coolant flow, 

and produce a hot spot on the plate.  If the hot spot were to get hot enough, the plate 

could fail, leading to a release of fission products into the reactor coolant loop. 

 Two factors helping to prevent flow induced deflection of the plates are the 

curvature of the plates and the presence of a comb at the leading and trailing edges.  In 

order to determine the actual benefit provided by both the comb and curvature, the 

research process focused on first identifying the deflection potential of a flat plate 

without a comb.  This design was used experimentally to provide an upper bound for 

plate deflection.  Additionally, the data from these experiments is useful in validating 

coupled fluid-structure interaction numeric simulations. 

 Validation of this novel FSI technique is critical, especially when considering the 

application of this analysis to a nuclear reactor system.  Presently, only a handful of 

codes are available to solve FSI problems.  The major disadvantage of these codes is that 

they generally rely only on CFD or FEA solution methods.  These single method solution 

techniques lead to potentially significant disadvantages when adapting FEA to fluid 

problems, or CFD to sold mechanics problems.  The dual method solution technique 

presented here avoids these concerns by ensuring a CFD code solves only for the fluid 

domain, and an FEA code solves only for the solid domain. 
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Chapter 3: Numeric Modeling 

Code Coupling Process 

 In order to numerically solve for the effect of coolant flow on plate deflection, a 

computational fluid dynamics code, Star-CCM+, has been explicitly coupled with a finite 

element method code, Abaqus.  Initially, this process was executed manually using a 

combination of Java and Fortran scripts to write data to external files.  However, within 

the past year, the numeric codes have advanced and now include an integrated method 

for exchanging data between the programs.  While this new technique does not afford 

the user the same level of control found in the scripting approach, it is significantly 

advantageous due to the data exchange process being completely automated, and not 

requiring that pressure and deflection data be written to external files before being read 

into the appropriate program. 

 After first running the fluid and solid models independently, the FSI co-

simulation, based on a cyclic four step process, is executed.  After building and meshing 

the independent solid and fluid domains in Abaqus and Star-CCM+, the co-simulation 

process described in Figure 5 is executed until a converged, steady state solution is 

obtained.  While the overall steady state FSI solution process is time independent, the 

Solve for the 
Fluid Model 
(Star-CCM+) 

Export static 
pressure at the 

FSI interface 

Solve for Solid 
Model (Abaqus) 

Export new 
geometry 

definition at FSI 
interface 

FIGURE 5.  FSI CO-SIMULATION PROCESS 
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final FSI solution is found through the use of time dependent solutions from the CFD and 

FEM codes.  The use of transient solvers in the CFD and FEM codes is necessary due to 

the use of differing solution techniques in the two codes.  The CFD code utilizes an 

Eulerian solution process that solves for fluid motion through discrete control volumes, 

and the FEM code utilizes a Lagrangian solution process that solves for the deformation 

of discrete volumes of material in the body.  To allow for simultaneous solution of both 

the fluid and solid domains, the physical values at the interface between the domains 

are utilized as boundary conditions for both codes.  To facilitate updating of the 

boundary condition values, a ‘pseudo-time’ step is used to provide intervals at which 

data can be exchanged between the programs. 

CFD Solution Process 

 To model the fluid domain, a computational fluid dynamics (CFD) code Star-

FIGURE 6. BASIC GEOMETRY FROM CFD MODEL.  NOTE THE GAP IN THE MIDDLE OF THE FLOW 
CHANNEL FOR THE PLATE. 
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CCM+ was utilized (CD-Adapco, 2011).  The basic geometry, shown in Figure 6, consists 

of a long, rectangular flow channel with a void where the plate is located.  With flow 

being from the top down, the model includes an entrance plenum to allow for flow 

development, and an exit plenum to allow for pressure equalization at the end of the 

plate.  In the case of a free leading edge boundary for the plate, much of the analysis is 

focused on the flow around the leading edge of the plate at the midpoint of the span.  

Figure 7 shows examples of the mesh, pressure, and velocity data available at this 

location.  This data is useful for validating analytic and experimental results. 

 

As shown in Figure 7, the CFD code works by discretizing the fluid domain into 

small control volumes.  In a transient solution process, the domain is updated at discrete 

time intervals.  To solve for the updated fluid domain, a general CFD transport equation 

FIGURE 7. EXAMPLES OF MESH, PRESSURE, AND VELOCITY AT THE LEADING EDGE OF A PLATE. 
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methodology is used.  The transport quantity φ is described by the general differential 

equation, 

 
𝜕

𝜕𝑡
(𝜌𝜙) + 𝛻(𝜌 ⃗𝜙) = 𝛻(𝛤𝛻𝜙) + 𝑆 (1)  

where ρ is the density,  ⃗ is the velocity, Γ is the diffusion coefficient, and S is the source 

term.  The terms in Eq. 1 are, from left to right, the unsteady (transient) term, the 

convection term, the diffusion term, and the source term.  The variable φ represents 

any of a number of quantities, including enthalpy, velocity, or turbulent kinetic energy 

(Patankar, 1980).  In order to be utilized by a numeric code such as Star-CCM+, Eq. 1 

must be discretized so it can be applied to a control volume.  In Star-CCM+, Eq. 2 is used 

as the discretized form of Eq. 1 (CD-Adapco, 2011). 

 
𝑑

𝑑𝑡
(𝜌𝜙𝑉)𝑖 +∑[𝜌𝜙( ⃗ ∙  ⃗ − 𝐺)]𝑓 = ∑(Γ∇𝜙 ∙  ⃗)𝑓 + (𝑆𝜙𝑉)𝑖

𝑓𝑓

 (2)  

where 𝑉 is the volume,  ⃗ is the face area vector, and the subscripts f and i denote the 

cell face and solver iteration, respectively.  From Eq. 2, the unsteady term can be 

discretized through a first or second order scheme.  When running CFD simulations 

alone without code coupling, it is adequate to discretize the unsteady term through the 

first order Euler implicit scheme, as described in Eq. 3.  This scheme is used to ascertain 

the initial flow field condition prior to running an FSI simulation. 

 
𝑑

𝑑𝑡
(𝜌𝜙𝑉)𝑖 =

(𝜌𝑖𝜙𝑖)
𝑛+1 − (𝜌𝑖𝜙𝑖)

𝑛

Δ𝑡
𝑉𝑖 (3)  

where n denotes the time step and Δ𝑡 is the length of a time step.  For FSI simulations, 

to help promote stability as the simulation progresses, it is advantageous to use the 
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previous two time steps when discretizing the unsteady term.  Therefore, the second 

order temporal discretization scheme shown in Eq. 4 is utilized. 

 
𝑑

𝑑𝑡
(𝜌𝜙𝑉)𝑖 =

3(𝜌𝑖𝜙𝑖)
𝑛+1 − 4(𝜌𝑖𝜙𝑖)

𝑛 + (𝜌𝑖𝜙𝑖)
𝑛−1

2Δ𝑡
𝑉𝑖 (4)  

Additionally, because the FSI process is used to find the steady state solution, the 

transient solution is not of particular interest.  Therefore, ‘time’ as considered in the 

context of the FSI problems presented here is actually a ‘pseudo-time’, in that the time 

variable is used solely as a means to provide an interval for data exchange between the 

two codes.  The time steps used in the CFD code, combined with the inertial motion of 

the plate boundary make transient fidelity difficult to obtain with current modeling 

techniques. 

The convection term, as shown in Eq. 5, is discretized based not only on the mass 

flow through a cell, but also on the flux through the cell due to the morphing of the fluid 

mesh to accommodate the new solid geometry. 

 
[𝜙𝜌( ⃗ ∙  ⃗ − 𝐺)]𝑓 = ( ̇𝜙)𝑓 =  ̇𝑓𝜙𝑓 (5)  

The grid flux term, G, is a volumetric flux which is calculated at each cell face when the 

fluid mesh is morphed due to the deflection calculated in the FEM model.  To provide 

stability to the FSI solution, the grid flux term can be relaxed at each time step.  While 

this has the effect of limiting the change in the fluid solution due to the motion of the 

interface and leads to a longer overall run time, it can also be useful in ensuring 

simulation stability. 
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The third term in Eq. 5 provides the diffusion gradient of the variable φ between 

cells in the mesh.  The source term is neglected as no mass or heat generation is present 

in the model. 

FEM Solution Process 

 To find a solution to the plate deflection problem, a finite element code, Abaqus 

was utilized.  The plate modeling process involved building a three dimensional solid 

model of the plate in Abaqus, and then meshing the model with 8 node or 20 node 

solid, deformable elements, as defined in Figure 8.  This element type was chosen for its 

ease of use when coupling with an FSI simulation.  Another option for modeling thin 

plates is to use shell elements.  However, given the relatively large deflections expected 

with these models, shell elements would yield less accurate results. 

  

To mesh the model, the edges were seeded to provide the spacing for the nodes.  

Then, a mesh was generated as shown in Figure 9.  On the outside edges of the plate, a 

clamped boundary condition was applied, and the mesh is coarser at these locations 

FIGURE 8.  ABAQUS NODE AND ELEMENT SURFACE DEFINITIONS (SIMULIA, 2011). 
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due to the absence of any deflection.  Additionally, the mesh was made significantly 

more dense through the thickness of the plate to help provide a more accurate profile 

of the plate deflection and stresses.  These deflection and stress values, as shown in 

Figure 9, are visualized at the completion of a simulation.  Additionally, plots are created 

of the out of plane deflection across the leading edge of the plate for comparison to 

analytic models. 

Stability 

 The nature of FSI modeling lends itself to instabilities in the solution process.  For 

instance, it is critical to ensure that the CFD model reaches a converged solution at each 

time step before exporting the pressure field to the FEM model.  Failure to export a 

FIGURE 9.  FEA MODEL MESH, STRESS, AND DEFLECTION PLOTS 
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converged pressure field at a time step will result in an inaccurate solution to the solid 

model.  This inaccuracy propagates through subsequent steps, yielding an unstable, 

divergent solution.  Because much of the difficulty in ensuring a converged solution 

comes from the CFD solution, criteria for solution convergence have been established.  

Within the CFD model, the static wall pressure and wall shear stress are monitored as 

the solution iterates.  The solution is not considered converged until both of these 

criteria have reached a steady solution for a given time step. 

 In addition to ensuring a converged solution at each time step, other controls are 

used to prevent dramatic changes in the solution between time steps.  Due to the high 

aspect ratio of the geometry under consideration, any large deflection of the plate or 

large change in the pressure field between time steps could make it difficult for the 

solvers to find a converged solution in subsequent time steps.  In the CFD model, 

pressure under-relaxation factors are used to dampen the response of the pressure field 

between time steps.  In the FEM model, mass proportional damping is applied as a 

material property to the model. 

 To determine the damping factors for the FEM model, Abaqus is used to 

complete a modal analysis prior to running the FSI simulation.  From this modal analysis, 

the first vibration mode is extracted, and 10% critical damping is applied.  In the Abaqus 

model, the fraction of critical damping, ξ, is defined through application of mass 

proportional and stiffness proportional damping factors α and β to the natural 

frequency ω. 
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𝜉 =
𝛼𝑅
2𝜔𝑖

+
𝛽𝑅𝜔𝑖

2
 (6)  

To critically damp the model, ξ should be equal to 1.  However, given the uncertainty 

associated with determining the natural frequency of the plate through purely numeric 

means, ξ is targeted for approximately 10% of the estimated critical damping. 

 A final stability control is to gradually ramp the pressure load on the plate at the 

start of the simulation.  This prevents `shocking’ the FEM model with a large pressure 

load in the initial step.  The pressure ramping is controlled through Star-CCM+, and 

involves ramping the pressure on the entire surface of the plate to approximately 1/3 of 

the maximum expected pressure, and then gradually ramping from that point to the 

actual pressures experienced by the plate.  Because the pressure is dependent upon the 

inlet velocity, pressure ramping can alternatively be applied by ramping the velocity of 

the flow at the inlet of the fluid model.  Both techniques work well, but the direct 

method tends to be more efficient as it maintains a converged fluid solution throughout 

the course of a simulation.  This reduces the number of iterations necessary in the fluid 

solution at each time step, and therefore reduces the overall run time. 

Efficiency 

 To assist with these FSI simulations, a mini cluster of high performance 

workstations has been constructed.  This cluster consists of three workstations, a 

desktop, and a server/controller.  For most simulations, two workstations are typically 

used, providing 8 Intel Xeon cores at 2.4 GHz, and 12 Intel Xeon cores at 3.33 GHz.  

Additionally, post processing is completed on a desktop with 4 Intel Core i7 cores at 3.33 
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GHz.  Even with these machines, simulation runtimes are still a concern.  Depending on 

the model being investigated, and the density of the fluid mesh, a single FSI simulation 

can take anywhere from a couple of days to a month to complete. 

 The primary factor in determining the run time of an FSI simulation is the density 

of the CFD mesh.  Higher density meshes which are on the order of 22 million + cells will 

take almost a month to complete.  For this reason, much focus has been on ways to 

maintain simulation accuracy and stability through the use of meshes with densities on 

the order of 5 million cells or less.  These simulations tend to complete in only a few 

days.  Conversely, meshes which have very low density tend to yield unstable and 

inaccurate results. 
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Chapter 4: Analytic Modeling 

Flow Model Development 

 To model the flow around a single plate, a basic geometry was designed which 

contains a flat, rectangular plate with channel gaps of differing thicknesses on either 

side.  The geometry considered is shown in Figure 10, and includes regions for flow 

development at the inlet and exit of the plate region. 

To determine the pressure drop through the assembly without considering plate 

deflection, a simple equation was developed to account for pressure drop from friction, 

flow contraction at the leading edge of the plate, and flow expansion at the trailing edge 

of the plate.  The frictional pressure drop is defined by Eq. 7, where the hydraulic 

diameter, Dh is shown in Eq. 8. 

FIGURE 10.  ASSEMBLY GEOMETRY.  FLUID FLOW IS FROM THE TOP DOWN 
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∆𝑝𝑓𝑟𝑖𝑐𝑡𝑖𝑜𝑛 = 𝑓
𝐿

𝐷ℎ

𝜌𝑉2

2
 (7)  

 

𝐷ℎ =
4𝑏ℎ

2(𝑏 + ℎ)
=

2𝑏ℎ

(𝑏 + ℎ)
 (8)  

 

The friction factor is defined by the Colebrook equation, Eq. 11, and is dependent on Eq. 

12, the Reynolds number and surface roughness of the channel.  It is important to note 

that only cases in the turbulent regime are being considered here, where the Colebrook 

equation is known to be valid (White, 2003). 

 
1

√𝑓
= −2.0𝐿𝑜𝑔10 (

휀

3.7
+

2.51

𝑅𝑒√𝑓
) (9)  

 

𝑅𝑒 =
𝜌𝑉𝐷ℎ

𝜇
 (10)  

 

To account for the pressure contribution from the contraction at the leading edge of the 

plate, Eq. 11 is utilized, and expansion at the trailing edge of the plate is found using Eq. 

12.  These equations apply to the geometries outlined in Figure 11 (White, 2003). 

 

∆𝑝𝑐𝑜𝑛𝑡𝑟𝑎𝑐𝑡𝑖𝑜𝑛 =
𝜌𝑉1

2

2
∗ 0.42 ∗ [1 − (

𝐴2

𝐴1
)
2

] (11)  

 

∆𝑝𝑒𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛 =
𝜌𝑉1

2

2
∗ [1 − (

𝐴1
𝐴2

)
2

]

2

 (12)  
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Because much of the other analysis revolves around mass flow rates, Eq. 13 was used to 

modify Eqns. 7,10,11 and 12. 

 
 ̇ = 𝜌𝑉𝐴 (13)  

This yields Eqns. 14-17: 

 

∆𝑝𝑓𝑟𝑖𝑐𝑡𝑖𝑜𝑛 = 𝑓
𝐿

𝐷ℎ

 ̇2

2𝜌𝐴2
 (14)  

 

𝑅𝑒 =
 ̇𝐷ℎ

𝜇𝐴
 (15)  

 

∆𝑝𝑐𝑜𝑛𝑡𝑟𝑎𝑐𝑡𝑖𝑜𝑛 =
 ̇2

2𝜌𝐴1
2 ∗ 0.42 ∗ [1 − (

𝐴2

𝐴1
)
2

] (16)  

 

∆𝑝𝑒𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛 =
 ̇2

2𝜌𝐴1
2 ∗ [1 − (

𝐴1
𝐴2
)
2

] (17)  

To determine the flow rate in each channel, an iterative approach is used.  Initial 

guesses of the flow rates in each channel are taken in order calculate approximate 

Reynolds numbers and friction factors.  Then, by factoring out the  ̇2 term from 

equations 14, 16, and 17, and summing them, coefficients for pressure drop in each 

channel are found.   

A1 

A2 
A1 

A2 

FIGURE 11. FLOW CHANNEL CONTRACTION (LEFT) AND EXPANSION (RIGHT). 
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𝑐∆𝑝,𝑐ℎ𝑎𝑛𝑛𝑒𝑙 =
∆𝑝𝑐𝑜𝑛𝑡𝑟𝑎𝑐𝑡𝑖𝑜𝑛

 ̇𝑐ℎ𝑎𝑛𝑛𝑒𝑙
2 +

∆𝑝𝑓𝑟𝑖𝑐𝑡𝑖𝑜𝑛

 ̇𝑐ℎ𝑎𝑛𝑛𝑒𝑙
2 +

∆𝑝𝑒𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 ̇𝑐ℎ𝑎𝑛𝑛𝑒𝑙
2  (18)  

By knowing the total flow rate into the assembly, a system of equations is solved to find 

the flow rate in each channel that produces an equal pressure drop in each channel.  

This system yields Eqns. 19 and 20. 

 

 ̇𝑐ℎ𝑎𝑛𝑛𝑒𝑙 1 =  ̇𝑡𝑜𝑡𝑎𝑙

√𝑐∆𝑝,𝑐ℎ𝑎𝑛𝑛𝑒𝑙 1

√𝑐∆𝑝,𝑐ℎ𝑎𝑛𝑛𝑒𝑙 1 +√𝑐∆𝑝,𝑐ℎ𝑎𝑛𝑛𝑒𝑙 2
 (19)  

 
 ̇𝑐ℎ𝑎𝑛𝑛𝑒𝑙 2 =  ̇𝑡𝑜𝑡𝑎𝑙 −  ̇𝑐ℎ𝑎𝑛𝑛𝑒𝑙 1 (20)  

If these values differ from the guessed values, then the Reynolds number and friction 

factor are recalculated, and the process is repeated until a converged solution is found.  

A converged solution is typically found in less than five iterations.  Once a converged 

solution for the flow rates is found, these values are substituted back into Eqns. 14, 16, 

and 17 and summed together to get the total pressure drop over the plate region.  To 

find the pressure drop contribution from the inlet and exit regions, Eq. 14 is solved using 

the total flow rate into the assembly. 

Deflection Model Development 

 The frictional pressure drop through the channels on either side of the plate 

produces a linear net pressure force along the length of the plate.  The maximum 

pressure force occurs at the leading edge of the plate, and reduces to no net pressure at 

the trailing edge of the plate.  The plate displays maximum deflection at the leading 

edge with no deflection at the trailing edge.  Because the maximum deflection is of 
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greatest concern, initial modeling utilized a simple 1-D beam equation to estimate the 

deflection of the leading edge.  

 

𝛿 =
𝑝𝑥2

24𝐸𝐼
(𝑏 − 𝑥)2(1 − 𝜈2) (21)  

Equation 21 can be integrated over the plate width and divided by b to find the average 

deflection. 

 

𝛿𝐴𝑉𝐸 =
∫ 𝛿𝑑𝑥
𝑏

0

𝑏
=

𝑝𝑏4

60𝐸 3
(1 − 𝜈2) (22)  

Knowing that the maximum deflection will be at the midpoint of the plate, Eq. 21 can be 

solved for x=b/2 to yield a model for the maximum plate deflection. 

 

𝛿𝑚𝑎𝑥 =
𝑝𝑏4

32𝐸 3
(1 − 𝜈2) (23)  

 

By examining Eq. 23, it can be seen that deflection is a cubic function of plate thickness 

and a quartic function of width.  Given that the new fuel plates are being thinned down 

by 24%, and that the plates are significantly wider than they are thick, it is easy to 

understand why deflection is a potential concern in the new fuel design. 

 A simple wide beam model is useful for describing the qualitative deflection of 

the plate, and matches closely to numeric models where flow redistribution isn’t 

considered.  This provides a metric that can be used to validate the independent CFD 

and FEA models before the FSI problem is considered. 
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Chapter 5: Flat Plate Modeling 

Computational Models 

 In the new MURR fuel assembly, the fuel plates are curved, adding to their 

rigidity.  Additionally, there is a comb at the leading and trailing edges of the plates, 

pinning them in place at the midpoint of those edges.  Bearing in mind that a curved 

plate will present greater resistance to flow induced deflection than a flat plate, the 

present analysis has instead focused on modeling a flat plate, as shown in Figure 12, in 

order to determine a bounding case for plate deflection.  Additionally, the dimensions 

selected for the plate are roughly based on the dimensions of plate 23 from the new 

MURR assembly, as this is the most extreme case in the design.  In order to correlate 

well with experimental results, the focus has been on monolithic aluminum plates, 
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foregoing the composite structure for the time being.  While it is helpful from a 

modeling perspective to start with a simplified geometry, there is also cause from a fuel 

qualification perspective to start with this type of model.  If it can be shown that this 

worst case scenario is capable of withstanding the hydraulic forces present in the 

reactor, then future work on more prototypic models will serve to illustrate the margin 

available in the design.  However, if the worst case scenario shows significant deflection, 

then additional work will be necessary to verify that the real fuel plates are actually rigid 

enough to withstand the hydraulic forces in the flow loop. 

 To analyze this flat plate model, a worst case scenario was simulated.  This 

involved using a 0.8128 mm (32 mil) thick flat plate with channels of 2.032 mm (80 mil) 

and 2.540 mm (100 mil) on either side. 
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The plate model shown in Figure 13 was first modeled in Abaqus.  Mesh density, and 

particularly the density of the mesh through the thickness of the plate, was gradually 

increased to ensure that the solution was not dependent on the mesh.  From Figure 14, 

it can be seen that for a given pressure load, the maximum deflection seen on a plate 

changed very little with variation in the number of solid elements through the thickness. 

 Using the mesh of the solid plate model, a fluid model was built in Star-CCM+ 

around the solid model.  This fluid model contains the outer surface of the plate, the 

fluid channel walls, and the inlet and exit boundaries.  The solid model itself is not 

present in the fluid model, and the fluid boundary at the location of fluid structure 

interaction is co-located with the surface of the plate, providing the same geometric 

definition for the FSI boundary.  Like the solid model, the fluid mesh was modified to 

gradually higher densities until an acceptable mesh was obtained.  From Figure 15, the 

results from this mesh independence study show that as the mesh density neared 2 
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million cells, the discrepancy in the solutions for numerous flow rates dropped to near 

zero.  As the mesh density was incrementally increased, the percent change in the 

pressure solution was found by comparing the pressure drop of the current, higher 

density mesh with that of the previous mesh, as described in Eq. 24. 

 

% 𝐶ℎ 𝑛𝑔𝑒 =
𝑃𝑐𝑢𝑟𝑟𝑒𝑛𝑡 − 𝑃𝑝𝑟𝑒𝑣𝑖𝑜𝑢𝑠

𝑃𝑝𝑟𝑒𝑣𝑖𝑜𝑢𝑠
∗ 100 

(24)  

 Once the solid and fluid models were constructed and the meshes validated, 

each code was run independently to verify that the independent models were valid 

prior to coupling through an FSI simulation.  The coupled FSI simulation was set up by 

modifying the Abaqus input file to contain the commands for co-simulation.  

Additionally, the Star-CCM+ model was modified with the co-simulation parameters.  

These co-simulation parameters can be found in Appendix 1.  
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To ensure the CFD solution reaches convergence prior to exchanging data with 

the FEM solution, the approximate fluid transit time from inlet to outlet is utilized as the 

CFD time step.  The FEM model is allowed to use time steps smaller than the CFD model, 

but cannot use a step size larger than the CFD model.  This typically results in the FEM 

model taking multiple steps for each CFD step early on in the coupled simulation.  In 

later increments, as the simulation approaches a steady state solution, the programs 

step at the same, constant CFD step size.  To help determine the influence of flow rate 

on deflection, the same model was run at multiple flow rates.  Additionally, the pressure 

profile in the fluid channels was extracted from the models for comparison to analytic 

and experimental results. 

Experimental Setup 

The flow loop shown in Figure 16 was constructed at the University of Missouri 

to analyze different plate and channel configurations.  The primary purpose of the flow 

loop is to provide validation of the numeric models.  The loop is instrumented with 

numerous tools to assist in analysis, including a pressure transducer, laser displacement 

measurement heads, a flow meter, and a pneumatic valve for flow control.  These 

systems are controlled by an automated LabView system to complete flow tests. 

To complete testing, a test section was designed for use in the flow loop.  The 

test section shown in Figure 17, was constructed to simulate the same geometry from 

Figure 13.  For the purposes of this analysis, only a single assembly was analyzed, as 

outlined previously.  However, the test section is easily reconfigurable to accommodate 

a wide range of plate and channel sizes.  Additionally, the section can hold an array of 
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up to five plates to assist in analyzing the effects of larger plate arrays.  These tests are 

outside the scope of the current study, but may happen in later tests. 

 Prior to testing the assembly shown in Figure 13, measurements were taken 

using the optical laser heads to determine the initial channel gaps and any preexisting 

curvature to the plate.  The lasers were first used to sweep across the width of the test 

section just above the leading edge of the plate.  This measurement gives the profile of 

the gap between the two plexi glass panels (h1 + h2 + a as a function of b).  Next, the 

lasers were lowered down to the leading edge of the plate and used to map the profile 

of the flow channels on either side of the plate (h1 and h2).  From the channel profiles 

FIGURE 16.  MISSOURI FLOW LOOP 
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shown in Figure 18, there appears to be a slight curvature of the plate into the larger 

channel, as indicated by the narrowing of the larger channel near the middle of the 

plate.  Additionally, the overall channel gap narrows at the center indicating a slight 

curvature to the plexi glass outer panels.   shows the average channel gap thicknesses 

from Figure 18.  In addition to using the laser heads to measure the channel gap at the 

leading edge, manual measurements of the channel spacer and plate thicknesses were 

taken prior to assembly of the test section.  These measurements were taken along the 

full length of the spacers and plates, not just the leading edge.   

FIGURE 17.  FLAT PLATE TEST SECTION. 
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Finally, because the lasers will be located at the center (b/2), leading edge 

position of the plate during flow tests, it is important to have a good understanding of 

the dimensions at this location.  The lasers were used to measure the thickness of the 

plexi glass, the channel gaps with air, and the distance from the outside of the plexi 

glass to the surface of the plate with water in the channels, as shown in Table 2.  Due to 

the differing indices of refraction for air, plexi glass, and water, these values are 

necessary for determining correction factors for the laser heads so the data obtained 

during the flow tests can be properly interpreted. 

  

FIGURE 18. CHANNEL GAP PROFILES. 
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TABLE 1. SUMMARY OF ASSEMBLY DIMENSIONS. 

 
Design Assembly 7 Sweep Micrometer 

Gap h1 
2.540 mm 2.258 mm 2.432 mm 

100.000 mils 88.913 mils 95.767 mils 

Gap h2 
2.032 mm 1.899 mm 1.952 mm 

80.000 mils 74.744 mils 76.869 mils 

Plate a1 
0.813 mm 0.9037 mm 0.815 mm 

32.000 mils 35.579 mils 32.105 mils 

h1+h2+a1 
5.385 mm 5.061 mm 5.200 mm 

212.000 mils 199.236 mils 204.705 mils 

 

TABLE 2. THICKNESS MEASUREMENTS AT CENTER, LEADING EDGE OF PLATE. 

 
Design 

GapAir Plexi Plexi + GapWater Correction 

Factor   (Actual) (Measured) (Measured) 

Gap h1 
2.540 mm 1.936 mm 15.828 mm 17.339 mm 

1.281 
100.000 mils 76.232 mils 623.130 mils 682.622 mils 

Gap h2 
2.032 mm 1.796 mm 15.698 mm 17.002 mm 

1.377 
80.000 mils 70.713 mils 618.035 mils 669.374 mils 

 

 While the test section was designed around the values outlined in Figure 13, it is 

obvious that the channels in the actual assembly are slightly thinner than the designed 

values.  This variation, although small, will be important when comparing to results from 

the numeric simulations, which were based on the idealized values from Figure 13.  The 

slight decrease in channel thickness will lead to higher flow velocities and a slightly 

different pressure distribution than the numeric model at the same flow rate. 

Once all initial measurements were completed, the test section and flow loop was 

prepared for flow testing.  LabView was used to control the flow rate and collect data on 

the flow rate, pressure, and plate deflection.  To complete the flow test, the flow rate 

was started at the lowest possible value, and gradually increased to the maximum value 
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that the pump is capable of.  Once at the maximum value, that flow rate was held 

constant for several minutes while measurements were taken at 18 different pressure 

taps along the length of both channels.  Once these pressure measurements were 

completed, the flow rate was gradually returned to the minimum value, and the test 

completed.  The results from this test are outlined in Chapter 6, along with the 

corresponding analytic and numeric results.  It should be noted that in the case of the 

numeric results, the idealized geometry was used, and therefore it varies slightly from 

the actual, measured geometry of the test section. 

   

 



41 
 

Chapter 6: Flat Plate Results and Discussion 

Experimental Results 

 Using the assembly outlined in Figure 13, flow tests were completed to 

determine the deflection at the leading edge of the plate.  In the initial phase of the test, 

the flow rate is gradually increased with LabView recording the channel gap and flow 

rate.  The change in the channel thickness at the midpoint is shown in Figure 19, with 

the flow rate profile shown in Figure 20.  Since the flow rate is based on an incremental 

closing of a valve in a circular pipe, a function based on the sum of two sine curves 

works well to define the flow rate as a function of the experiment time.  This equation is 

necessary so that the data collected from the lasers and the pressure transducer can be 

plotted against the flow rate data.  Because the flow rate data is based on a frequency 

FIGURE 19. CHANNEL GAP AT MIDPOINT DURING INTIAL TEST PHASE. 
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measurement that is dependent upon the flow rate of the water, the data collected 

from the flow meter is independent of that collected from the lasers or the pressure 

transducer.  Essentially, although the data collection rate for the lasers and the pressure 

transducer is synchronized, the flow data is not.  Equation 24 was fit to the flow rate 

data in Figure 20.  Using the flow rate data along with the average values of channel 

thickness from the initial profile in Figure 18, the average velocity of the fluid over the 

plates was plotted as Figure 21. 

 
 ̇(𝑡) =  1 sin(𝑏1𝑡 + 𝑐1) +  2𝑠𝑖𝑛(𝑏2𝑡 + 𝑐2) 

where:  a1 = 20.44 
 b1 = 0.01934 
 c1 = -0.3285 
 a2 = 18.67 
 b2 = 0.0211 
 c2 = 2.729 

(25)  

 

FIGURE 20. FLOW RATE DURING THE INITIAL TEST PHASE. 
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 Using the flow velocity from Figure 21 with the channel gap data of Figure 19, we 

can now determine the deflection of the plate as a function of fluid velocity.  This form 

of the deflection profile is convenient since most existing literature on flow induced 

plate deflection uses fluid velocity as the driving force in determining plate deflection.   

 
𝑉(𝑡) =  1 sin(𝑏1𝑡 + 𝑐1) +  2𝑠𝑖𝑛(𝑏2𝑡 + 𝑐2) 

where:  a1 = 40.7 
 b1 = 0.01925 
 c1 = -0.3242 
 a2 = 36.82 
 b2 = 0.02119 
 c2 = 2.725 

(26)  

Figure 22 shows the deflection data from channel 1 as a function of the fluid velocity.  

Note that the plate deflection is into the larger channel. 

FIGURE 21.  FLOW CHANNEL VELOCITY DURING INITIAL TESTING PHASE. 



 44 

 To determine the pressure distribution in both channels, the test was repeated 

with the flow rate held steady at its maximum while pressure data was recorded in both 

flow channels.  The pressure for the two channels shown in Figure 23 was collected at 

18 total pressure taps (9 in each channel).  The tap positions are noted in the figure.  

Using a linear trendline, the pressure values at the leading and trailing edges of the 

plate (i.e. the first and last pressure values for each channel) were extrapolated and 

included in the figure.  It is interesting to note that the pressures appear to equalize 

closer to the leading edge of the plate rather than the trailing edge.  This deviation from 

the simple analytic model is the result of flow redistribution due to plate deflection, 

which the analytic model neglects.  Additionally, the higher pressure was recorded in 

the smaller channel, which corresponds to the data showing the plate deflecting into 

the larger channel.  Using the data from Figure 23, the profile of the pressure 

FIGURE 22. MAXIMUM PLATE DEFLECTION VS. FLOW VELOCITY. 
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differential along the channel can be determined, and is shown as Figure 24.  Appendix 

2 contains the raw data from this portion of the test. 

For rectangular channels without considering flow redistribution, the plot of 

Figure 24 would be expected to be linear.  However, since the plate has deflected 

significantly and the flow has redistributed, the definition of the pressure differential 

through the thickness of the plate becomes significantly more complex.  These results 

are similar to results found by others in that the pressure profile loses a linear 

distribution as the plate deflects (Scavuzzo, 1965).   

Finally, the third phase of the test called for gradually reducing the flow rate 

back to its minimum value.  Like the first phase, data was recorded on the channel gaps 
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and flow rate.  These results are similar to those shown in Figs. 18 & 19, and are 

presented in Appendix 2. 

Computational Results 

The FSI co-simulation technique allows for using CFD and FEM codes to solve for 

their respective domains, passing information between the codes at the interface 

between the solid and fluid domains.  The solvers used by both codes are transient 

based solely for the purposed of providing a method for exchanging data between the 

programs at set intervals.  Since the codes currently lack the capability to provide 

transient fidelity for this analysis, the goal is to find the steady state solution of plate 

deflection, utilizing ‘time’ solely as a parameter for data exchange.  While these two 

particular codes provide built in functionality for explicit coupling of the fluid and solid 

domains, it is difficult to maintain simulation stability for applications containing a 

constrained fluid domain and high aspect ratio geometry.  Therefore, work has focused 
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on finding a method for stabilizing the simulations to provide accurate solutions for the 

geometries present in reactor fuel assemblies. 

Initial studies revealed that simulation stability can be achieved at the expense 

of computational time (efficiency).  By utilizing very high density fluid domain meshes, 

instabilities in the fluid pressure field are controlled.  However, this method involves 

fluid meshes in the tens of millions of cells, and can take up to a month to complete.  

Therefore, multiple options were explored to allow for the use of lower density fluid 

meshes without losing simulation stability.  Since instabilities in the coupled simulations 

arise from sudden acceleration of the coupled fluid-solid interface, these methods are 

targeted at controlling the velocity and limiting the acceleration of the interface.  These 

methods include scaling the fluid mesh anisotropically, damping the motion of the solid 

region, and ramping the fluid velocity and pressure values from lower levels up to the 

desired values.  Velocity and pressure ramping has proven especially useful in 

preventing a shock to the solid model that causes instabilities to propagate during 

iterations of the simulation. 

In order to evaluate the effectiveness of each of these techniques, a simplified 

model similar to that shown in Figure 13 was created.  These models used a uniform 

geometry with properties shown in Table 3.  Additionally, an inlet region above the 

leading edge of the plate has been incorporated to allow for prototypic flow. 
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TABLE 3.  FSI MODEL PROPERTIES 

Parameter Value 

Plate Thickness (a) 0.9652 mm = 0.038 in 

Plate Length (L) 647.7 mm = 25.5 in 

Plate Width (b) 110.3 mm = 4.342 in 

Young’s Modulus (E) 70 GPa = 10 x 106 psi 

Poisson’s Ratio (ν) 0.33 

Water Density (ρ) 997 kg/m3 = 1.93 slugs/ft3 

Water Viscosity (μ) 8.8871x10-4Pa-s = 1.85x10-5lb.-s/ft2 

Front Channel Gap (h1) 2.4 mm = 0.0955 in 

Back Channel Gap (h2) 2.2 mm = 0.0875 in 

CFD Model 1 Mesh 6,174,614 Cells 

CFD Model 2 Mesh 22, 385, 474 Cells 

 

One method considered to improve the stability of the simulation is to ramp the 

fluid velocity from a low level to the desired level over the course of the simulation.  In 

both models 1 and 2, the inlet velocity was ramped from 3 m/s to 8 m/s.  Model 1 used 

a constant acceleration model, and Model 2 used a more gradual acceleration, as shown 

in Figure 25. 

As shown by Equation 7, the velocity of the flow through a channel has a direct 

effect on the pressure in that channel.  Given that the instabilities seen in earlier FSI 

models were the result of sudden changes in pressure on the interface surface, the 

ramped velocity method shown in Figure 25 was developed in order to indirectly ramp 

the pressure on the interface surface. Another method of directly ramping the interface 

pressure is provided by the CFD code.  Later models have explored the option of directly 

ramping the exported pressure on the fluid-structure interface without the need to 

ramp the fluid velocity.  This method provides the advantage of maintaining a 
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converged fluid field solution while simultaneously controlling the pressure exported to 

the FEM model. 

A plot of the plate deflection results for Model 1 is shown in Figure 26.  As can be 

seen, this simulation diverged, producing an unrealistic deflection.  After analysis of the 

results from both the CFD and FEM models, the initial instability in the simulation was 

traced back to the pressure field of the CFD solution.  As the simulation reached higher 

velocities in later time steps, the pressure field did not reach a converged solution prior 

to exporting pressure data to the FEM solver.  While this initially started as a small 

perturbation of the solution, it quickly propagated and resulted in unrealistic pressure 

distributions in the channels on both sides of the plate. 
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In order to address the issues presented by the poor fluid solution, the 

simulation was run again with two significant changes.  The changes to Model 2 included 

a large increase in the mesh density of the fluid model, and a more gradual ramping of 

the inlet fluid velocity.  A comparison of the fluid field mesh through a portion of the 

flow cross-section is shown in Figure 27 to illustrate to changes between the 

simulations.  These two modifications increased the resolution of the fluid pressure field 

and decreased the changes in the fluid field between iterations.  Together, these 

FIGURE 26.  DEFLECTION PROFILE CAUSED BY NUMERIC INSTABILITY IN MODEL 1. 
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modifications worked to dampen out instabilities in the fluid field as the simulation 

progressed, thereby preventing the instabilities from propagating through the 

simulation. 

FIGURE 27.  COMPARISON OF THE MESH FROM MODEL 1 (LEFT) AND MODEL 2 (RIGHT). 
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As a result of these changes, a stable solution was achieved.  The plate deflection 

results from Model 2 shown in Figure 28 present a more realistic deflection profile.  As is 

shown through the analytic model, the pressure differential through the thickness of the 

plate is expected to be at its maximum at the leading edge.  The results from Model 2 

reinforce this conclusion by showing a maximum deflection at the leading edge that 

tapers off along the length of the plate. 

FIGURE 28.  DEFLECTION PROFILE CAUSED BY NUMERIC INSTABILITY IN MODEL 1. 
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After Model 2 completed, the static pressure profile on either side of the plate was 

plotted along the length of the plate.  These pressure curves, shown in Figure 30, show a 

linear pressure drop along both surfaces of the plate.  The maximum pressure 

differential, at the leading edge of the plate, is approximately 7000 Pa, as shown in 

Figure 29. 
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As seen in Figure 29, when compared to the experimental data, the qualitative 

profile of the pressure differential found in the numeric results is significantly different.  

However, the comparative magnitude of the pressure values is quite similar.  This 

supports the conclusion that while more work is necessary to refine the models to 

improve accuracy, the numeric models are capable of supporting the experimental data.  

Additionally, while Model 2 did produce a significantly more stable solution than Model 

1, the major drawback was the computational time required to find the solution.  

Running in parallel across 12 processors, Model 2 still took 25 days to complete.  The 

expectation is that a single simulation takes no more than four days to complete.  

Therefore, additional investigation is necessary in order to produce fluid meshes with 

the magnitude of Model 1, while still maintaining the stability of Model 2. 
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Since the maximum deflection occurs at the leading edge of the plate, Figure 31 

was created to show the leading edge deflection.  Also, since the simulation was run 

through a range of velocities, the data was extracted and plotted at various inlet velocity 

conditions to illustrate the increase in leading edge deflection as the velocity increased. 

Plotting a curve fit to the data sets shown in Figure 31 shows that the profile of the 

deflection is a fourth order polynomial.  This qualitatively matches the profile predicted 

analytically by Eq. 21.  However, when quantitatively compared to the analytic model in 

Figure 32, there is significant deviation.  This deviation is likely due to the analytic model 

being based off of wide beam deflection equations.  These models tend to lose accuracy 

with large deflections.  Given that the magnitude of deflection of the plate is on the 
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order of the thickness of the plate, the analytic models from current literature are likely 

insufficient to predict deflection. 
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Chapter 7: Conclusion and Future Work 

The primary focus of this research was to set up stable, explicitly coupled fluid 

structure interaction models utilizing Abaqus and Star-CCM+.  This work has been 

successful in providing a means for completing these FSI models.  Significant difficulty 

was found in producing CFD meshes which are dense enough to produce a stable 

solution, but not so dense that the simulation run times are excessive.  A potential 

solution to this problem involves using Abaqus to mesh both the CFD and FEM models, 

producing CFD meshes which are an order of magnitude smaller than those produced in 

Star-CCM+.  The Star-CCM+ mesher works well for larger, open objects with reasonable 

aspect ratios.  However, in this application, the high aspect ratio of the channels forces 

the mesher to create overly dense meshes, and to produce low quality cells at the 

surface of the plate. 

 Building the solid model was significantly simpler than the fluid model.  The 

solver for the FEM model allows for damping coefficients to be included in the material 

properties, thereby damping out excessive motion of the plate caused by inertia.  This 

allowed for easy control of plate motion to help arrive at a steady state solution.  

Additionally, ramping the pressure output from the CFD model to the FEM model as the 

simulation iterates provides additional control to the stability of the model. 

 The techniques presented here detail the work in developing stable, efficient FSI 

models.  The focus of this work was to develop techniques for FSI coupling and meshing 

of models.  Additionally, parameters to control the stability of the simulations were also 

investigated.  With this work now complete, future attention will turn to ensuring the 
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accuracy of the solutions from the FSI models.  At present, there is inadequate 

experimental and analytic data available to directly verify the FSI results. 

As the experimental studies on flow induced plate deflection continue, further 

FSI models will be run to check their accuracy, and to make adjustments where 

necessary.  At present, experiments are planned for flat and curved plate assemblies of 

one or more plates.  These should yield good data for comparison to FSI models.  Once 

validated against experiments, new analytic models of plate deflection will also be 

developed.  Much of this work has already begun, and it is apparent that a closed form 

solution for large deflection of a plate with two clamped and two free edges will be 

difficult, if not impossible.  The experimental and numeric work to come will be used in 

inform an approximate solution to this problem. 

The work to develop fluid structure interaction technology is just beginning.  

Given the continued advances in computational power, this field of study will only see 

increasing growth in the years to come.  Coupling of codes for flow induced deformation 

analysis is only the beginning, with work now expanding to include coupling for thermal 

and even neutronics analysis.  This is merely the first step toward developing 

technologies to fully model complete, complex engineering systems. 
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APPENDIX 1: Numeric Procedure (Tutorial) 

Introduction 

This tutorial presents the basic procedure for setting up and running a coupled Fluid-

Structure Interaction (FSI) simulation using Star-CCM+ and Abaqus.  This tutorial focuses 

on mechanical deformation analysis of a rectangular flat plate in a high velocity flow.  

The procedure can be easily adapted for more complex mechanical systems and also for 

thermal analysis. 

The following processes are covered in this tutorial: 

 Installing Star-CCM+ and Abaqus 

 Setting up system environment variables 

 Preparing the Abaqus solid model 

 Modifying the Abaqus input file 

 Preparing the Star-CCM+ fluid model 

 Setting up the coupled simulation 

 Executing the coupled simulation 

 Viewing the results 

Preparing for Coupled Simulations 

Required Software 

Ensure the following programs are installed for coupled FSI simulations: 

 Star-CCM+ 5.06.007 or newer 
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o Change the installation directory from the default of “C:\Program 

Files\CD-Adapco” 

 to “C:\CD-Adapco” 

 Abaqus 6.10-2 or newer 

 Recommended: Notepad++ (http://notepad-plus-plus.org/) 

System Configuration 

Add the following system environment variables: 

 Variable: SIMULIA_CSE_LIBS 

Value:  C:\SIMULIA\Abaqus\6.10-2\exec\lbr 

 Add the following to the system PATH environment variables 

o %SIMULIA_CSE_LIBS%\exec\lbr 

o %SIMULIA_CSE_LIBS%\External 

Create the following directory structure on the computer being used for the analysis.  If 

this analysis is being run on one of the workstations in the lab, this directory should 

reside within the “C:\SimTemp” folder.  This will allow the simulation to run from the 

high speed solid-state drive on the workstation.  Note that due to the limited size of the 

solid-state drive, all completed simulations should be moved either temporarily to the 

D: drive on the workstation, or permanently to the high capacity drive on the network 

controller. 

 SimulationFolder 

o Abaqus 

o Star-CCM+ 

http://notepad-plus-plus.org/
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After making these changes, reboot the computer. 

Preparing the Abaqus Solid Model 

Building the Model in Abaqus CAE 

This section outlines the creation of the Abaqus input file using the Abaqus CAE GUI.  

The input file contains all the information necessary to run an Abaqus simulation 

including node and element definitions, material definitions, and the analysis and 

output definitions. 

1. Launch Abaqus CAE: Start -> All Programs -> Abaqus 6.10-2 -> Abaqus CAE 

 

 

2. In the ‘Start Session’ dialog, select ‘Create Model Database With 

Standard\Explicit Model’ 
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3. Set the working directory to the Abaqus directory created earlier: File -> Set 

Work Directory 

 

Then change the work directory (For this tutorial, C:/SimTemp/Co-

SimTutorial/abaqus) 
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Select ‘OK’ 

 

4. Save the CAE file: File -> Save As 

 

Save the file as ‘plate.cae’ in the work directory 

 

Select ‘OK’ 

 

5. Next, begin building the model by working through each of the modules in the 

Model tree on the left side of the screen.  Start by double-clicking on the ‘Part’ 

module: 
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The ‘Create Part’ dialog is displayed. 

 

Name the part ‘PLATE’.  Make it a 3D, Deformable, Solid, Extrusion with an 

approximate size of 1.  Select Continue. 

The sketching plane is displayed.  Create a rectangle with a width of 0.1102868 

m (4.342 inches) and a length of 0.6477 m (25.5 inches).  Ensure that the bottom 

left corner of the rectangle is at the origin. 
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Select ‘Done’ at the bottom of the sketch window. 

Enter an extrusion depth of 0.0009652 m (0.038 inches). 

 

Select ‘OK’ 

 

6. Next, define a material by double-clicking on the ‘Materials’ module in the 

Model tree: 
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The ‘Edit Material’ dialog is displayed. 

Name the material ‘ALUMINUM’ 

Select the following properties: 

o General -> Density 

 Mass Density:  2700 

o Mechanical -> Elasticity -> Elastic 

 Young’s Modulus: 70000000 

 Poisson’s Ratio:  0.33 

o Mechanical -> Damping 

 Alpha:   4 
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 Select ‘OK’ 

7. Next create a section for the material by double-clicking ‘Sections’ in the Model 

tree. 

 

The ‘Create Section’ dialog is displayed. 
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Name the section ‘PlateSection’, and select the ‘Solid’ and ‘Homogenous’ 

options.  Click ‘Continue…’ 

In the Edit Section dialog, accept the default settings and select ‘OK’ 

 

 

8. Next, create a section assignment for the Part ‘Plate’ by double-clicking the 

‘Section Assignments’ node in the Plate part tree: 
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The message below the viewport window will prompt you to, “Select the regions 

to be assigned a section.”  Click on the plate in the window to select it. 

 

The plate will be outlined in red.  Select ‘Done’ below the viewport window. 

In the Edit Section Assignment dialog, accept the default settings and select ‘OK’ 

 

 

9. Next, create the assembly.  Double-click the ‘Instances’ Node under the 

‘Assembly’ module in the Model tree: 
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Accept the default settings in the ‘Create Instance’ dialog and select ‘OK’ 

 

 

10. Create a set for the sides of the plate.  This set will later be used to assign a 

boundary condition for the side edges of the plate.  Double-click the ‘Sets’ node 

under the ‘Assembly’ module in the Model tree: 
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Name the set ‘FIXSIDES’ and click continue 

 

Select the two long edge surfaces of the plate 

 

Select ‘Done’ below the viewport window. 
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11. Create a surface indicating where the fluid comes into contact with the plate.  

Double click the ‘Surfaces’ node under the ‘Assembly’ module in the model tree: 

 

The ‘Create Surface’ dialog is displayed. 

 

Name the surface ‘FSI_INTERFACE’ and click ‘Continue…’ 

Select the four surfaces in contact with the fluid (Front, Back, Top and Bottom) 
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Click ‘Done’ below the viewport window to complete the surface definition. 

 

12. Next, define the analysis step.  Double-click the ‘Steps’ module in the Model 

tree: 

 

The ‘Create Step’ dialog is displayed 
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Leave the step name as ‘Step-1’.  Change the type to General -> Dynamic, 

Implicit.  Select ‘Continue…’ 

The ‘Edit Step’ dialog is displayed: 

 

Set the following parameters on the ‘Basic’ tab: 

o Description: FSI Co-Simulation with Star-CCM+ 

o Time Period: 2.2 

o Nlgeom: On 
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Set the following parameters on the ‘Incrementation’ tab: 

o Type: Fixed 

o Maximum number of increments: 10000 

o Increment size: 0.05 

Click ‘OK’ 

13. Define the Boundary Conditions.  Double-click on the ‘BCs’ module in the Model 

tree: 
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The ‘Create Boundary Condition’ dialog is displayed 

 

Name the Boundary Condition ‘FIXSIDES’.  Select a Mechanical, 

Symmetry/Antisymmetry/Encastre type.  Select ‘Continue…’ 
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Click ‘Sets’ below the lower-right corner of the viewport window 

The ‘Region Selection’ dialog is displayed 

 

Select the ‘FIXSIDES’ set, and click ‘Continue…’ 

The Edit Boundary Condition dialog is displayed 
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Select ‘ENCASTRE (U1 = U2 = U3 = UR1 = UR2 = UR3 = 0)’ and click ‘OK’ 

 

14. Seed the Model.  The seed values used here produce a relatively fine mesh.  

They can be adjusted to change the overall mesh density. 

Double-click the ‘Mesh’ node under the Plate Part Module: 

 

On the top menu bar, select Seed -> Edges 

 

The prompt below the viewport states to ‘Select the regions to be assigned local 

seeds’.  To specify a custom seed through the thickness of the plate, select the 

four short corner edges of the plate. 



 79 

 

Click ‘Done’ below the viewport window. 

The Local Seeds dialog is displayed. 

 

Set the ‘Method’ to ‘By Number’, and the ‘Number of Elements’ to 5. 

Click ‘OK’ 

Repeat this procedure to select the four edges through the width of the plate 
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Click ‘Done’ below the viewport window. 

The Local Seeds dialog is displayed 

 

Set the ‘Method’ to ‘By Number’, and the ‘Number of Elements’ to 50. 

Click ‘OK’ 

Finally, select the four remaining edges through the length of the plate 
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Click ‘Done’ below the viewport window. 

The Local Seeds dialog is displayed 

 

Set the ‘Method’ to ‘By Number’, and the ‘Number of Elements’ to 300. 

Click ‘OK’ 

Click ‘Done’ below the viewport window. 

 

15. Meshing the Model.  From the top menu bar, select Mesh -> Element Type 
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The Element Type dialog is displayed 

 

Set the following properties for the element type: 

o Element Library: Standard 

o Family: 3D Stress 

o Geometric Order: Quadratic 

Select ‘OK’ 

From the top menu bar, select Mesh -> Controls 
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The Mesh Controls dialog is displayed 

 

Ensure that a Hex, Structured mesh is selected and click ‘OK’ 

Finally, from the top menu bar, select Mesh -> Part 

 

In the prompt below the viewport, click ‘Yes’ to mesh the part. 

 

16. Writing the input file.  Now that the model is meshed, the input file can be 

written. 

First, create a job.  Double-click the ‘Jobs’ module under the Analysis tree: 
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The Create Job dialog is displayed. 

 

Name the job ‘38milPlate’ and click ‘Continue…’ 

The Edit Job dialog is displayed.  Click ‘OK’. 

Now Right-Click on the newly created job and select ‘Write Input’. 
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Abaqus will write the input file to the working directory. 

 

Editing the Abaqus INput File 

Open the Abaqus input file, 38milPlate.inp, in Notepad++.  Scroll all the way to the 

bottom and add the missing lines to the Output History section.  The end of the file 

should appear as follows: 

*Output, field, variable=PRESELECT, frequency=1 

**  

** HISTORY OUTPUT: H-Output-1 

**  

*Output, history, variable=PRESELECT, frequency=1 

** 

*CO-SIMULATION, NAME=FSI_Mech, PROGRAM=MULTIPHYSICS, CONTROLS=Control-1 

*CO-SIMULATION REGION, TYPE=SURFACE, EXPORT 

ASSEMBLY_FSI_INTERFACE, U 

ASSEMBLY_FSI_INTERFACE, VEL 

*CO-SIMULATION REGION, TYPE=SURFACE, IMPORT 

ASSEMBLY_FSI_INTERFACE, CF 

*CO-SIMULATION CONTROLS, NAME=Control-1, COUPLING SCHEME=GAUSS-SEIDEL, SCHEME 

MODIFIER=LAG, 

STEP SIZE=0.05, TIME INCREMENTATION=SUBCYCLE, TIME MARKS=YES 

** 

*End Step 

 

Bolded items need to be added to the file for the co-simulation and output settings. 

The following is an overview of what each of these commands does: 

*Output, field, variable=PRESELECT, frequency=1 

**  

** HISTORY OUTPUT: H-Output-1 

**  

*Output, history, variable=PRESELECT, frequency=1 

** 

These write field and history output to the output database file (*.odb) during the 

simulation.  Data is written at every time step by setting the frequency to 1. 

 

*CO-SIMULATION, NAME=FSI_Mech, PROGRAM=MULTIPHYSICS, CONTROLS=Control-1 

This line begins the co-simulation definition.  The Name is arbitrary, and the control set 

for the co-simulation is defined on a later line. 
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*CO-SIMULATION REGION, TYPE=SURFACE, EXPORT 

ASSEMBLY_FSI_INTERFACE, U 

ASSEMBLY_FSI_INTERFACE, VEL 

These 3 lines specify what values should be exported from Abaqus to Star-CCM+.  The 

surface is defined by ASSEMBLY_SURFACE_NAME, where SURFACE_NAME is the name 

given to the FSI surface when building the model.  The variable ‘U’ is used to export 

nodal displacement, and ‘VEL’ is used to export nodal velocity. 

 

*CO-SIMULATION REGION, TYPE=SURFACE, IMPORT 

ASSEMBLY_FSI_INTERFACE, CF 

These 2 lines specify what values should be imported to Abaqus from Star-CCM+.  The 

surface for the import is defined the same as for the export step.  The value ‘CF’ is used 

to import wall shear stress and static pressure on the surface of the plate. 

 

*CO-SIMULATION CONTROLS, NAME=Control-1, COUPLING SCHEME=GAUSS-SEIDEL, SCHEME 

MODIFIER=LAG, 

STEP SIZE=0.05, TIME INCREMENTATION=SUBCYCLE, TIME MARKS=YES 

These 2 lines specify the co-simulation controls referenced in the initial co-simulation 

definition line.  The NAME must match the controls name in the initial co-simulation 

line. 

The coupling scheme is set to Gauss-Seidel.  This scheme has only Abaqus or Star-CCM+ 

running at a given time (i.e. serial coupling).  Data is updated at intervals specified by 

the step size parameter. 

Setting the Scheme Modifier to Lag means that Abaqus will run second in the co-

simulation. 
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Setting the Time Incrementation to Subcycle allows Abaqus to reduce the increment size 

if necessary.  If this happens, Abaqus will run multiple increments until reaching the 

required step size before exchanging data with Star-CCM+. 

Time Marks set to Yes requires Abaqus to reach the specified step size in an exact 

manner, rather than going past it before exchanging data. 

 

Something else to note is the Step definition in the input file.  It appears just before the 

code shown above and should look like this: 

** STEP: Step-1 

**  

*Step, name=Step-1, nlgeom=YES, inc=10000 

FSI Co-Simulation with Star-CCM+ 

*Dynamic,direct 

0.05,2.2, 

The two numbers in the final line dictate the step size for the Abaqus simulation and the 

total time of the simulation.  The step size (0.05) can be equal to or less than that 

specified in the co-simulation definition.  If it is less than what is in the co-simulation 

definition, then the co-simulation step size must be a multiple of the number in the step 

definition.  For example, if you want Abaqus to iterate 10 times before exchanging data 

with Star-CCM+, then change the 0.05 in the step definition above to 0.005. 

 

This completes preparation of the Abaqus model.  Save the changes to the input file and 

CAE model and close Abaqus. 

 

Preparing the Star-CCM+ Fluid Model 
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NOTE: Star-CCM+ tends to be a little glitchy and temperamental.  Therefore, you should 

save early and save often to avoid losing any work! 

Building the Fluid Model 

1. Open Star-CCM+ 5.06.007.  From Windows, go to Start -> All Programs -> CD-

Adapco -> Star-CCM+ 5.02.007 for Windows 64. 

 

Click ‘Yes’ in the User Account Control Window 

Star-CCM+ starts up. 

 

2. Begin a new simulation.  From the top menu bar, go to File -> New Simulation 
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The Create a New Simulation dialog is displayed 

 

For building a model, only a single processor is needed.  Therefore, the Run 

Mode of Serial will be used.  Click ‘OK’. 

 

3. Define the FSI walls.  Import the Abaqus model by going to File -> Import -> 

Import CAE Model 
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The Open dialog is displayed 

 

Locate the Abaqus Input File created earlier, and select ‘Open’. 

The Import Options dialog is displayed 
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Ensure that ‘Create new Imported Model,’ ‘Run mesh diagnostics after import,’ 

and ‘Open geometry scene after import’ are selected, and ‘Create new Region’ is 

deselected.  Click ‘OK’ 

 

Once the model is imported, you now need to define a new part wraps the outer 

surface of the plate.  Since the plate is nothing more than a rectangular block, 

this can be done relatively easily in Star-CCM+. 

In the model tree on the left of the screen, expand the ‘Geometry’ node.  Right-

click on the ‘Parts’ container and select New Shape Part -> Block. 
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The left pane changes to show the part Edit controls.  Also, a preview of the 

block is shown in the open Geometry Scene. 

 

By default, Star-CCM+ has the new part enclose anything shown in the active 

scene.  In this case, that is the imported plate geometry.  Additionally, since the 

plate is a rectangular block aligned with the axes, the new block created by Star-

CCM+ perfectly wraps the surface of the imported Abaqus model.  This part will 
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be used to define the FSI Interface of the fluid model.  Click ‘Create’ at the 

bottom of the Edit pane to create the block. 

 

Although it can’t be seen, the block has been created.  Before closing the edit 

pane, we need to create another block to define the outer walls of the fluid 

channel.  This channel will the same width as the plate (the X dimensions will be 

identical).  Along the length, it will extend 7.5 inches (0.1905 m) up to the inlet 

from the top of the plate (Y2 = 0.64770001 + 0.1905 = 0.83820001) and extend 3 

inches (0.0762 m) down to the outlet from the bottom of the plate (Y1 = 0 – 

0.0762 = -0.0762).  This model is meant to simulate the plate being offset a 

distance of 4 mils (0.004 inches, 1.016e-4 m) in a channel with a total thickness 

of 221.13 mils (.22113 inches, 5.6168e-3 m).  Therefore, Z1 is set to -0.0022242 

and Z2 is set to 0.0033962. 
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Click ‘Create’, then ‘Close’. 

If you expand the ‘Parts’ container, you will see the two parts that were just 

created. 

At this point, save the simulation to the star-ccm+ directory created at the 

beginning of the tutorial.  Go to File -> Save As 
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The Save dialog is displayed 

 

Name the file ‘OffsetPlate.sim’ and click ‘Save’. 

 

4. Now that the geometries necessary for defining the fluid region are in place, the 

Imported Abaqus Model can be removed.  Expand the ‘Imported Models’ 

container, right-click on the imported model, and select ‘Delete’. 

 

The Confirm Object Deletion dialog is displayed 
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Click ‘Yes’ 

You will now notice that the Geometry Scene is empty.  To display the two blocks 

that were just created, click the ‘scene/plot’ button above the model tree. 

 

Double click on the Geometry Scene 1 -> Displayers -> Geometry 1 -> Parts 

Container to display the Edit dialog 

 

Expand the Parts container, and select the check boxes next to the two parts 

shown in the list.  Click ‘OK’. 
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Now drag the Parts container from the Geometry 1 displayer down to the Parts 

container of the Outline 1 displayer.  Finally, click on ‘Geometry 1’ in the 

Displayers container.  In the properties pane at the lower left corner of the 

screen, scroll down to the ‘Expert Options’ and set the ‘Representation’ option 

to ‘Geometry’.  Repeat this for the ‘Outline 1’ displayer. 

 

The two geometry parts should now be displayed in the scene. 

 

5. Defining the boundaries.  Return to the simulation controls by clicking 

‘simulation’ above the model tree. 

Expand the Geometry -> Parts container.  Rename ‘Block’ to ‘FSI_INTERFACE’ by 

right-clicking on it, and selecting ‘Rename’. 



 98 

 

Enter the name FSI_INTERFACE in the Rename dialog and click ‘OK’ 

 

Rename Block 2 to OUTER 

Use Ctrl+click to select both parts (FSI_INTERFACE and OUTER).  Right-click on 

them and select Boolean -> Subtract Parts 
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In the Subtract Parts dialog, select the part you want to keep, in this case, 

OUTER. 

 

Click ‘OK’ 

A new part named ‘Subtract’ has been created.  Rename it FLUID. 

Update the Geometry Scene to show only the FLUID part. 

Expand the FLUID -> Surface container.  You will see two surfaces.  One of these 

is the four walls of the FSI_INTERFACE.  The other is the six walls of the outer 

channel.  Rename the surface representing the FSI_INTERFACE as FSI_INTERFACE 

(clicking on the surface names in the model tree will highlight them in the 

geometry scene). 
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Now the Inlet and Outlet surfaces need to be split off from the remaining Block 

Surface.  Right-click on the Block Surface representing the outer wall of the 

channel, and select Split By Patch… 

The Split Part Surface by Patch pane is displayed. 
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As you click each of the 6 Part Surface Patches in the list, that surface is 

highlighted in the scene.  You may need to pan around to see them as they are 

highlighted.  In the Split Part Surface by Patch pane, identify the two patches 

corresponding to the Inlet and Outlet.  In this case, they should be numbers 21 

and 23. 

Select patch 21 and click ‘Create’.  Repeat for patch 23.  Click ‘Close’. 

In the model tree, rename the Block Surfaces appropriately as INLET, OULET, and 

WALL. 



 102 

 

This would be a good time to save. 

6. Creating the Region.  Right-click on the FLUID part and select Set Region -> New. 

 

The New Regions from Parts Options dialog is displayed 
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IMPORTANT!! Change the Boundary Mode option to ‘One boundary per part 

surface’.  DO NOT use the default of ‘One boundary for all part surfaces’!  Click 

‘OK’ 

 

You can now collapse the Parts folder and expand the Regions folder to see the 

new FLUID region. 

 

Expand the FLUID -> Boundaries container, click on INLET, and change its type to 

‘Velocity Inlet’ in the properties pane. 
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Repeat the procedure, changing the OUTLET boundary to a ‘Pressure Outlet’. 

 

7. Defining Physics Continuum.  Collapse the ‘Regions’ folder.  Right click on the 

‘Continua’ folder and select ‘Physics Continuum’. 

 

Right-click on Physics 1 and click ‘Select models…’ 
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Select the following models: 

o Three Dimensional 

o Implicit Unsteady 

o Liquid 

o Segregated Flow 

o Constant Density 

o Turbulent 

o Reynolds-Averaged Navier-Stokes 

o K-Epsilon Turbulence 

o Realizable K-Epsilon Two-Layer 

o Two-Layer All y+ Wall Treatment 

The Physics dialog should look like this when you are done (with the exception of 

the Co-Simulation Option – it should not be selected yet): 
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Click Close. 

This would be a good time to save. 

 

8. Define Mesh Continuum.  Right-click on Continua.  Select New -> Mesh 

Continuum 

 

Right-Click on Mesh 1 and click ‘Select Meshing Models’ 
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Select the following models: 

o Surface Remesher 

o Trimmer 

o Prism Layer Mesher 

The Mesh dialog should look like this when you are done: 

 

Click Close. 

Expand the Mesh1 -> Reference Values folder.  The settings in this folder affect 

the quality and density of the mesh, and therefore the quality and run time of 

the simulation.  The following parameters are provided for an initial mesh, but 

can be changed to get a coarser or finer mesh.  You can also use Volumetric 

Controls to control the mesh in specific areas.  If desired, the surface can be 
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meshed first, and then the FLUID region scaled anisotropically.  Then the model 

can be meshed and scaled back out to its original dimensions.  This is useful for 

scaling the mesh along one or multiple axes. 

Change the following parameters: 

o Base Size: 9.652E-4 

o Number of Prism Layers: 3 

o Prism Layer Stretching: 1.2 

o Prism Layer Thickness -> Absolute Size -> 4.6516 E-4 

These parameters will produce a relatively fine mesh.  The easiest way to adjust 

the mesh density is to modify the Base Size. 

When you are ready to mesh, first save, then click the ‘Generate Volume Mesh’ 

button on the top toolbar. 

 

When complete, the mesh should be approximately 6,174,614 cells. 

 

9. Preparing the Initial Simulation.  Set the Continua -> Physics 1 -> Initial 

Conditions -> Velocity -> Constant Value to [0.0, -3.0, 0.0]. 
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Set the Regions -> FLUID -> Boundaries -> INLET -> Velocity Magnitude -> 

Constant Value to 3.0 m/s. 
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Set the Solvers -> Implicit Unsteady -> Time-Step Value to 0.5 s 

 

Set the Stopping Criteria -> Maximum Physical Time Value to 10.0 s 
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Right-click Reports.  Select New Report -> Area Averaged 
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Rename the report as InletPressure.  Set the Scalar Field Function to Pressure 

and the Parts to the FLUID: INLET boundary by clicking the … in the parts box. 

 

Repeat this for the Outlet Boundary, naming this report OutletPressure. 

Create a new Expression Report by Right-clicking Reports and selecting New 

Report -> Expression. 

Set the Dimensions to ‘Pressure’ by entering a 1 next to Pressure in the 

Dimensions dialog. 

 

Set the definition to: $InletPressureReport - $OutletPressureReport 
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Rename the report as PressureDrop.  Right-Click the PressureDrop report and 

select ‘Create Monitor and Plot from Report’ 

 

Right-click Stopping Criteria and select Create from Monitor -> PressureDrop 

Monitor 

 

Change the Criterion Option from Minimum to Asymptotic.  Click on ‘Asymptotic 

Limit’ and change the value for |Max-Min| to 0.5 Pa.  Change the Number of 

Samples to 15. 

Modify the Maximum Inner Iterations Stopping Criteria to 150. 
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Save the simulation. 

 

10. Run the initial simulation.  Close the simulation and re-open it in parallel, using 

as many processors as the system allows.  Once the simulation is loaded, click 

Run on the top toolbar. 

 

 

When the simulation reaches a converged solution, save it. 

Now go to Solution -> Clear Solution on the top menu bar 

 

In the dialog box, clear the Fields box and click OK.  This will keep the converged 

solution intact as the starting point for the next simulation. 

Save the simulation.  I would also recommend creating a copy of this file so that 

the converged initial solution is available should the file be saved again later on. 

 

11. Setting up Variable Velocity.  In Excel, create a table like the one below.  Save it 

in the star-ccm+ directory as a Comma Separated Values (velocity.csv) file.  
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time data 

0 3 

0.1 3.5 

0.2 4 

0.4 4.5 

0.5 5 

0.7 5.5 

0.8 6 

1 6.5 

1.1 7 

1.3 7.5 

1.4 8 

1.6 8.5 

1.7 9 

1.9 9.5 

2 10 

In Star-CCM+, under Tools, right-click on Tables and select New Table -> File 

 

Locate the velocity.csv file and click ‘Open’ 

Expand the Regions -> FLUID -> Boundaries -> INLET -> Physics Values -> Velocity 

Magnitude option.   



 116 

 

Change the Method from ‘Constant’ to ‘Table (time)’  

Click on ‘Table (time) in the Model tree and set the table to ‘velocity’.  Set Table: 

Data to ‘data’.  Change Interpolation from ‘Spline’ to ‘Step’ 
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Save the simulation. 

 

12. Set up the Co-Simulation.  Under Tools, right click on Motions.  Select New -> 

Morphing. 
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Add Co-Simulation to the Physics 1 continuum by right-clicking on Physics 1 and 

selecting ‘Select Models…’  Click the check box next to Co-Simulation and click 

Close. 

Under Regions -> FLUID -> Physics Values -> Motion Specification, change the 

Motion property to ‘Morphing’ 

 

Under Regions -> FLUID -> Boundaries -> FSI_INTERFACE -> Physics Conditions -> 

Morpher, change the Method to Co-Simulation. 
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Save the simulation. 

 

Make the following changes to the timing parameters of the simulation: 

o Solver -> Implicit Unsteady -> Time Step: 0.05 

o Stopping Criteria -> Maximum Physical Time: 2.2 

o Stopping Criteria -> Maximum Steps -> ensure that the ‘Enabled’ box is 

not selected 

 

Under Tools, right-click Co-Simulation and select ‘New Abaqus Co-Simulation’ 
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Set the following Co-Simulation properties: 

o Current Job Name: PlateDeflection (this can be any arbitrary name) 

o Executable Name:  abq6102.bat 

 I would recommend copying the abq6102.bat file from the 

SIMULIA\Abaqus\Commands directory into the simulation abaqus 

directory.  This helps to avoid issues with the system PATH in 

Windows 

o Abaqus Input File: C:\SimTemp\Co-SimTutorial\abaqus\38milPlate.inp 

o Coupled Boundaries: FLUID: FSI_INTERFACE 

o Exported Scalar Field Functions: Static Pressure 

o Exported Vector Field Functions:  Wall Shear Stress 

o Imported Vector Field Functions: Nodal Displacement, Velocity 
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o Number of CPUs:  4-12 depending on the system and license 

availability 

o Time-Marching Sequence: Star-CCM+ Leads 

o Ignore Grid Flux Terms: Checked 

The following is an overview of these settings in Star-CCM+ 

 

Save the simulation. 

 

13. Run the Co-Simulation.  Right-click on Abaqus Co-Simulation 1 and select 

Start/Restart Abaqus 
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Wait until the status bar between the model tree and the properties pane 

(where the moving green bar is) says, “Starting initial data transfer…: Finished.” 

Now click the ‘Run’ button on the top menu toolbar. 

 

14. Viewing results.  While the simulation is running, the abaqus *.msg file can be 

viewed in Notepad++.  It will provide several numbers, the most important of 

which is the maximum deflection for a given increment.  If this deflection is 

greater than the thickness of the fluid channel, the simulation will crash since the 

plate as deflected outside of the channel.  You can also open the abaqus *.odb 

file while the simulation is running to view the graphical results from Abaqus.  

This file should only be opened when Abaqus isn’t running (i.e. open it while 

Star-CCM+ is iterating)
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APPENDIX 2: Experimental Data 

FIGURE A 2. CHANNEL GAP DATA FROM PHASE 2 OF FLOW TEST. 

FIGURE A 1.  FLOW RATE DATA FROM PHASE 2 OF FLOW TEST. 
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 ̇(𝑡) =  1 sin(𝑏1𝑡 + 𝑐1) +  2𝑠𝑖𝑛(𝑏2𝑡 + 𝑐2) 

where:  a1 = 3.397 
 b1 = 0.009346 
 c1 = 1.516 
 a2 = 0.8027 
 b2 = 0.03776 
  c2 = 0.9763 

(27)  

 

 

  

FIGURE A 3. FLOW RATE DATA FROM PHASE 3 OF FLOW TEST. 
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FIGURE A 4. CHANNEL GAPS DURING PHASE 3 OF FLOW TEST. 
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APPENDIX 3: Numeric Data 

Abaqus Mesh Independence Study (varying number of elements through thickness) 
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Star-CCM+ Mesh Independence Study (varying number of cells) 
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